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Section 1

1 Specifications
This section provides specific information on the Regulatory Compliances, Agency Listings, 
Technical Specifications and Functional Specifications for the CPI Card Group - Spectrum card printer.

1.1 Regulatory compliance

Agency Regulatory Compliance

UL The card printer is listed under UL 60950-1 (2nd edition) Information Technology 
Equipment.
File Number: E145118

CSA The printer manufacturer has been authorized by UL to represent the card printer as 
CSA Certified under CSA Standard C22.2 No. 60950-1-07 2nd edition
File Number: E145118

FCC The card printer complies with the requirements in Part 15 of the FCC rules for a Class 
A digital device.

CE The card printer has been tested and complies with EN300-330, EN301-489, 
EN60950-1:2006 + A11:2009 + A1:2010 +A12:2011 + A2:2013, EN50581, and EN62479.
Note: Based on this testing, the printer manufacturer certifies that the card printer 

complies with the following of the European Community and has placed the CE 
mark on the card printer: RED 2014/53/EU, ROHS 2015/863/EU

Emissions and Immunity 
Standards

FCC Part 15 Class A, RSS-GEN, RSS 210, CNS 13438, EN55032 Class A, EN55024, 
EN6100-3-2, EN6100-3-3, EN300-330, EN301-489, GB9254, GB17625

Safety Standards UL IEC 60950-1 (2nd edition), CSA C22.2 No. 60950-1-07 (2nd edition), EN60950-1, 
GB4943, CNS14336

Additional Agency Listings CCC, BSMI, KC, EAC, BIS, MIC, RCM

Environmental GreenCircle Certified Energy Savings
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Specifications PLT-02931, Rev. A.1
1.1.1 United States
This device complies with Part 15 of the FCC rules. Operation is subject to the following conditions:

■ This device may not cause harmful interference.

■ This device must accept any interference received, including interference that may cause undesired
operation.

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference; in which case, 
correction of the interference is at the users expense.

Important: Changes or modifications to an intentional or unintentional radiator not expressly approved 
by the party responsible for compliance could void the user’s authority to operate the 
equipment.

1.1.2 Canada
This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the 
following two conditions: (1) this device may not cause interference, and (2) this device must accept any 
interference, including interference that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de 
licence. L'exploitation est autorisée aux deux conditions suivantes : (1) l'appareil ne doit pas produire de 
brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si le 
brouillage est susceptible d'en compromettre le fonctionnement.

Warning: 
This product can expose you to chemicals including Diisononyl Phthalate (DINP), which is known to the 
State of California to cause cancer. For more information go to www.P65warnings.ca.gov.
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1.1.3 Taiwan

經型式認證合格之低功率射頻電機，非經許可，公司、商號或使用者均不得擅自變

更頻率、加大功率或變更原設計之特性及功能。低功率射頻電機之使用不得影響飛

航安全及干擾合法通信；經發現有干擾現象時，應立即停用，並改善至無干擾時方

得繼續使用。前項合法通信，指依電信法規定作業之無線電通信。低功率射頻電機

須忍受合法通信或工業、科學及醫療用電波輻射性電機設備之干擾。

1.1.4 Japan

この装置は総務省の型式指定を受けています。"

( 総務省指定番号は第 AC-xxxxx 号です )

本製品は電波を使用した RFID 機器の読み取り・書き込み装置です。

そのため使用する用途・場所によっては、医療機器に影響を与える恐れがあります

1.1.5 Korea

이 기기는 업무용 (A 급 ) 전자파 적합기기로서 판매자 또는 사용자는 이 점을 주의하시길 바라며 , 가정 외의 지역에서 
사용하는 것을 목적으로 .
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1.2 Safety messages-United States

Symbol Critical Instructions for Safety Purposes

Danger: Failure to follow these guidelines results in personal injury or death. To prevent personal injury or death, 
reference the following safety messages before performing an operation:

■ Always remove the power cord prior to performing repair procedures, unless otherwise specified.
■ Ensure only qualified personnel perform these procedures.

ESD: This device is electro statically sensitive. Damage to the device may occur if it is exposed to static 
electricity discharges. To prevent damage, reference the following safety messages before performing 
an operation:

■ Observe all established Electrostatic Discharge (ESD) procedures while handling cables in or
near the circuit board and printhead assemblies.

■ Always wear an appropriate personal grounding device.
■ Always remove the ribbon and cards from the printer before making any repairs, unless otherwise

specified.
■ Remove jewelry and thoroughly clean hands before working on the printer.

Caution:
This symbol warns of an electrical hazard that could result in personal injury or death.

Caution:
For safety purposes, do not use Ethernet for a direct connection outside of the building.

Warning:
This symbol warns of a hot surface that could result in personal injury. 

E S D
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1.3 Safety messages-French Canada 

Symbol Instructions critiques visant la Sécurité

Danger: Si ces directives ne sont pas suivies les résultats peuvent être des lésions corporelles ou la mort.
Pour éviter des lésions corporelles ou la mort:

■ Rapportez-vous aux avis suivants de sécurité avant de procéder à une opération.
■ Retirez toujours le câble d’alimentation avant d’effectuer des procédures de réparation, sauf

spécification contraire.
■ Assurez-vous qu’uniquement des personnes qualifiées réalisent des procédures.

ESD: Ce dispositif est sensible à l’électricité statique. Il peut souffrir des dommages s’il est exposé à des 
décharges électrostatiques.
Pour éviter des dommages:

■ Rapportez-vous aux messages suivants avant de procéder à une opération.
■ Suivez toutes les procédures de Décharges Electrostatiques (ESD) en vigueur durant le

maniement des câbles dans ou à proximité des Ensembles de Cartes de Circuit Imprimé et Tête
d’Impression.

■ Portez toujours un dispositif de mise à la terre personnelle appropriée.
■ Retirez toujours le ruban et les Cartes de l’Imprimante avant d’effectuer toute réparation, sauf

spécification contraire.
■ Retirez tous bijoux et lavez soigneusement vos mains avant de travailler à l’Imprimante.

Attention:
Ce symbole est un avis de péril électrique passible de résulter en lésion corporelle ou mort.

Attention: 
Pour des motifs de sécurité, n’utilisez pas Ethernet pour une connexion directe hors du bâtiment.

Warning: 
This symbol warns of a hot surface that could result in personal injury. 

E S D
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1.4 Safety messages-Taiwan
繁體中文 射頻發射及安全指令 安全訊息 （小心檢查）

標記 重要的安全事項說明
危險 : 未按照說明安裝可能造成人員傷亡。

在可能產生潛在安全問題的地方有警示標記。

（如左圖所示）。

為了避免人員傷害，在進行有此警示標記的操作前，請先參考安全資訊提示。

為了避免人員傷害，在沒有特別說明的情況下，修理前請關掉電源開關。
小心 : 此設備對靜電很敏感。如果受到靜電放電，設備會損壞。

在可能產生潛在靜電安全問題的地方有警示標記。

（如左圖所示）。

為了避免損壞設備，在進行有此警示標記的操作前，請先參考安全資訊提示。

為了避免損壞設備，在排放電路板和印刷頭聯合裝置裡面或附近的電線時，請注意觀察所有的靜電放電設
備。

為了避免損壞設備，請隨時佩戴合適的接地裝置 （比如：手腕上戴一個高品質的接地手腕帶以免受到可能
的傷害）。

為了避免損壞設備，如果沒有特殊說明，在做任何修理前，請取下印表機上的色帶和卡。

為了避免損壞設備，在使用印表機之前，請摘下戒指和手上飾品，並仔細清洗手上的油脂。
警告使用者 :

這是甲類的資訊產品， 在居住的環境中使用時，可能會造成射頻干擾，在這種情況下，使用者會被要求採
取某些適當的對策措施

設備名稱： 　，型號（型式）：
彩色卡片熱感印表機 X002200-003 

單元Ｕnit

限用物質及其化學符號

鉛 Lead
(Pb)

汞 Mercury
(Hg)

鎘 Cadmium
(Cd)

六價鉻
Hexavalent 
chromium

(Cr+6)

多溴聯苯
Polybrominated 

biphenyls
(PBB)

多溴二苯醚
Polybrominated 
diphenyl ethers 

(PBDE)

電源 － ○ ○ ○ ○ ○
打印單元 － ○ ○ ○ ○ ○
金屬零件 － ○ ○ ○ ○ ○

備考 1. 〝超出 0.1 wt % 〞及〝超出 0.01 wt % 〞係指限用物質之百分比含量超出百分比含量基準值。
備考 2. 〝 ○ 〞係指該項限用物質之百分比含量未超出百分比含量基準值。

備考3.〝－〞係指該項限用物質為排除項目。
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1.5 Safety messages-China
安全消息 （请仔细阅读）

符号 涉及安全的重要过程
危险 : 如果不遵循这些安装指南进行操作，可能会导致重伤，甚至死亡。

可能引发安全问题的信息由警告符号 （如左图所示）来表示。

为了确保人身安全，在执行前面带有此符号的操作之前，请先阅读下面的安全消息。

为了确保人身安全，除非另有规定，否则在执行维修过程前，始终应断开电源。
小心 : 此设备为静电敏感设备。如果暴露在静电电流下，可能会损坏设备。

可能引发静电安全问题的信息由警告符号 （如左图所示）来表示。

为了防止设备或介质受损，在执行前面带有此符号的操作之前，请先阅读下面的安全消息。

为了防止设备或介质受损，请在处理电路板和打印头部件中或附近的电缆时，遵守所有规定的静电放电 
(ESD) 过程。

为了防止设备或介质受损，请始终佩带适当的个人接地设备 （例如，已接地避免出现潜在损坏的高质量腕
带）。

为了防止设备或介质受损，除非另有规定，否则在执行任何维修过程前，始终应将色带和证卡与打印机分
离。

为了防止设备或介质受损，在操作打印机前，请取下手指和手上的珠宝饰物，并将手上的油渍和污渍彻底
清洗干净。
仅适用于海拔 2000m 以下地区安全使用
Use only at altitudes not more than 2000m above sea level.

仅适用于非热带气候条件下安全使用

环境保护 ( 中国 -RoHS)

环保使用期是基于本产品用于办公环境。
Environmental Protection Use Period is based on the product being used in an office environment.

警告：

此为 A 级产品， 在生活环境中， 该产品可能会造成无线电干扰。 在这种情况下， 可能需要用户对其干扰采
取可行的措施。

2000m
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1.6 Technical specifications

Component Description

Card cleaning Replaceable cleaning roller (included with each print ribbon). Recommended cleaning 
cycle after 2,000 cards.

Card materials and types ■ Press polished PVC
■ Composite (PET/PVC with PVC as an outer layer)
■ Laminated PVC (credit card construction)
■ 100% PETG
■ 100% Polycarbonate

Card sizes supported These card printers accept standard CR-80 sized cards (3.370" L x 2.125" W / 85.6 mm 
L x 54 mm W) with a thickness of 30 mil.

Dimensions (H x W x D) Printer: 11.50" x 14.50" x 12" (292 mm x 368 mm x 305 mm)
Printer with dual-sided module: 11.50" x 19.75" x 12" (292 mm x 501 mm x 305 mm 

Display OLED graphical display

Encoding options Magnetic stripe:
■ ISO compliant, dual high/low coercivity, Tracks 1, 2 and 3
■ JIS II mag
■ Custom and raw

Contact and contactless smart card:
■ Contact—OMNIKEY® 5122
■ Contactless—OMNIKEY 5127 CK Mini
■ Programmer—OMNIKEY 5127 CK SI

HID Global certified supplies Note: The CPI Card Group - Spectrum printer requires highly specialized print ribbons to 
function properly. To maximize printer life, reliability, printed card quality and durability, 

you must use only HID Global certified supplies. For this reason, your HID Global 
warranty is void, where not prohibited by law, if you use non-HID Global certified 
supplies. To order additional materials, please contact your authorized reseller.

Hopper capacity—input ■ 100 cards, 30 mil—standard hopper
■ 200 cards, 30 mil—dual-input hopper (optional)

Hopper capacity—output 200 card output hopper capacity, 30 mil

Interface ■ USB 2.0 (high speed)
■ Ethernet (100 Mbps) with internal print server
■ Interfacing information for E-card options

HDP film options Clear film, 1,500 prints

HDP film storage 
temperature

77° F (25° C) or lower for no longer than 1.5 years.

Memory 1 GB
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Microsoft Windows 
compatibility

■ Windows 7 (32- and 64-bit)
■ Windows 8 / 8.1 (32- and 64-bit)
■ Windows 10 (32- and 64-bit)
■ Windows Server 2008 R1 (32- and 64-bit)
■ Windows Server 2008 R2 (64-bit only)
■ Windows Server 2012
■ Windows Server 2012 R2
■ Windows Server 2016

Operating conditions Operating temperature: 65 to 90° F (18 to 32° C)
Humidity: 20 to 80% non-condensing

Options ■ Dual-sided module
■ Magnetic stripe encoder
■ Contact encoder
■ Contactless encoder
■ Programmer encoder
■ Printer cleaning kit
■ Flattener

Print area Over-the-edge on CR-80 cards

Print colors Up to 16.7 million and 256 shades per pixel

Print method HDP dye-sublimation / resin thermal transfer

Print nodes HDP6600 DPI print head only

Print resolution 600 DPI

Print ribbon options Prints or images:
■ YMCK*—750 prints
■ YMCKK*—600 prints

*Indicates the ribbon type and the number of ribbon panels printed.
Key: Y = Yellow, M =Magenta, C = Cyan, and K = Resin Black

Print speed YMCK—Up to 230 cards per hour/16 seconds per card

Power source voltage, 
current & frequency

Supply voltage / Current: 100 to 240V AC, 3.5A maximum
Supply frequency: 50 Hz and 60 Hz

Ship weight Printer: 20.20 lbs (9.16 kg)
Printer with dual-sided module: 24.50 lbs (11.11 kg)

System requirements Access https://www.support.microsoft.com and search for your Microsoft Windows 
OS system requirements.

Warranty Printer: Three-year (one-year On-Call Express, US only)
■ Three-year factory warranty
■ Covers parts and depot repair
■ First year On-Call-Express (loaner printer US only)
■ Second year On-Call-Express available for a fee. This must be purchased before

the first-year On-Call-Express expires.
Printhead: Lifetime; unlimited pass with HID Global certified card

Component Description
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Section 2

2 Setup and installation
This section describes the setup and installation for the CPI Card Group - Spectrum card printer.

If you have a lamination unit to set up, see the HDP6600 Lamination Installation Guide (PLT-04395) that is 
included with the lamination unit for information.

2.1 Selecting a good location
The following guidelines help to ensure optimal printing performance:

■ Place the unit in a location with adequate air circulation to prevent internal heat buildup.

■ Use the dimensions of the printer as a guideline for the minimum clearances to the unit.

■ Allow for adequate clearance in front of the unit to accommodate the unit with its covers open.

■ Do not install the unit near heat sources such as radiators or air ducts or in a place subject to direct
sunlight, excessive dust, mechanical vibration, or shock.

2.2 Moisture condensation
If the unit is brought directly from a cold to a warm location or is placed in a a very damp room, moisture may 
condense inside the unit. Should this occur, print quality may not be optimal.

Leave the unit unplugged in a warm, dry room for several hours before using to allow any moisture to 
evaporate. 

Caution: For safety purposes, Ethernet is not intended for a direct connection outside of the building.
Attention: Pour des raisons de sécurité, Ethernet n'est pas conçu pour une connexion directe à l'extérieur 
du bâtiment.
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2.3 Unpacking and inspection
While unpacking the printer, inspect the carton to ensure that damage did not occur during shipping.

Make sure that all supplied accessories are included with the unit:

■ US/EU power cable

■ Card input cartridge

■ Card output hopper

■ Ferrite

■ USB cable

Make sure you have these accessories that are supplied separately:

■ HDP film

■ Print ribbon

■ Cards

2.4 Installing the HDP film
CPI Card Group - Spectrum High Definition printers require highly specialized supplies to function properly. This 
printer uses a refillable HDP film drawer. To maximize the printer durability, reliability and printed card 
quality, you must use only FARGO-certified supplies. If not using FARGO-certified supplies, your warranty is 
void, where not prohibited by law.

1. Open the front door.
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2. Slide out the HDP film drawer by pulling on the gray handle.

3. Unlatch and raise the accumulator unit. Twist the accumulator unit 90° to the right.

4. Pull down the HDP film loading handle.

Caution: Be careful not to touch the hot holler surface identified with this symbol.
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5. Load the HDP film, ensuring that each spool is correctly fitted to the corresponding color cartridge, and
the film is not loose.

Note: Used film should have used panels to the left of the purple roller and new panels to the right of
the purple roller. 

6. Push up the HDP film loading handle.

7. Twist the accumulator unit 90 to the left. Push down in the center of the accumulator unit until it clicks
into place.
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8. Slide the HDP film drawer in until the gray handle clicks/latches.

9. Close the printer front cover.
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2.5 Installing the print ribbon
Important: Do not connect the power supply or communication cable (USB or Ethernet) at this stage.

CPI Card Group - Spectrum High Definition printers require highly specialized supplies to function properly. This 
printer uses a refillable ribbon drawer. To maximize the printer durability, reliability and printed card quality, 
you must use only FARGO-certified supplies. If not using FARGO-certified supplies, your warranty is void, 
where not prohibited by law.

Each print ribbon includes a replaceable cleaning roller. The recommended cleaning cycle is after every 2,000 
cards printed.

1. Open the printer front cover.

2. Slide out the ribbon drawer by pulling on the gray handle.
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3. Pull down the loading handle.

4. Load the ribbon, ensuring that each spool is correctly fitted to the corresponding color cartridge, and
the ribbon is not loose.

5. Push up the ribbon loading handle.
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6. Slide in the ribbon drawer until the handle clicks/latches.

7. Close the printer front cover.

2.6 Installing the cleaning roller
Every HDP print ribbon contains a cleaning roller. Each time a new HDP print ribbon is inserted, a new 
cleaning roller should be installed.

1. Remove the protective sleeve from the cleaning roller.
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2. Insert the cleaning roller into the card input area. 

3. Attach the card input cartridge to the printer. 
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2.7 Installing blank cards into the input card hopper
Load the cards with the print side down and (if applicable) the magnetic stripe up and towards the front of 
the printer. 

Notes:

■ FARGO UltraCard® Premium card types are recommended (see Section 2.7.1 General card information).

■ Cards eject into the output hopper or reject hopper.

■ Each input hopper holds 100 cards.

1. Press the button to open the card input cartridge.

2. Load blank cards then close the card input cartridge.

Note: If using cards with a magnetic stripe, load the cards with the stripe facing up and towards the
front of the printer. 

3. Close the input card hopper door.
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4. Attach the card output hopper to the printer.

2.7.1 General card information
Important: For the best results and ISO card specification compliance, composite PVC is recommended 

over straight PVC.

■ The printer prints onto any card with a clean level, and polished PVC surface.

■ Suitable cards must have a polished PVC surface free of fingerprints, dust, or any other types of
embedded contaminants.

■ For best results, HID recommends UltraCard, UltraCard stock has a glossy PVC laminate on top and
bottom and is optically inspected to provide the cleanest, most scratch and debris-reduced cards
possible. Two types of UltraCard card stock are available.

■ UltraCard stock has a PVC core and offers medium card durability.

■ UltraCard Premium stock has a 40% polyester core and offers high durability (recommended).

Both types of UltraCards produce printed images with a glossy, photo-quality finish.
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2.8 Printer power
Important: Do not connect the printer USB cable until prompted during the printer driver installation.

To connect power to the printer:

1. Plug the power cable into the back of the printer. 

2. Plug the wall power cable into a standard 100-240 VAC power outlet.

3. Switch on the printer. 

Note: If the physical switch is left on and the printer is left idle, the printer enters a low power state. 
When a print job is sent, the printer restores full power and the print job commences.

Important: If connecting by Ethernet, add the ferrite (supplied with the printer) before plugging in the 
Ethernet cable.
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2.9 Driver installation instructions
To download and install the HDP6600 driver file:

1. Visit www.hidglobal.com/drivers and search for HDP6600. 

2. Click DOWNLOAD from the search results and click I ACCEPT to accept the End User License 
Agreement. 

3. Once the driver file has downloaded, double-click the .exe file to install the HDP6600 driver.

4. The installer verifies the contents of the setup package and the installation begins. Follow the on-screen 
instructions to complete the driver installation. Select your required language. Click Next. 

5. The Welcome to HDP6600 Card Printer Install screen is displayed. Click Next. 
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6. Read the license terms and conditions. Select I accept the license agreement and click Next. 
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7. Select the type of connection for the printer.

■ If you are connecting to a local connection, select Local Connection (USB) and click Next.

■ If you are connecting to a network, select Network Connection (Ethernet) and do the following:

a. Connect the Ethernet cable to the printer.

b. Enter the IP address of the printer.

a. Connect the printer to a power source and turn it on.

b. Click Next.
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8. The HID Printer Status Monitor can be installed with the driver. This is recommended and the checkbox
is selected by default. The HID Status Monitor is used to provide information about the printers
connected to this computer. Click Next.
34 July 2019



PLT-02931, Rev. A.1 Setup and installation
9. The Ready to Install window is displayed. Click Next to begin the installation.

10. If you are using a local connection (USB), the Plug and Play window is displayed to prompt you to turn
on the printer and connect the USB print cable. When the connections are recognized, the installation
continues.
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11. When the installation is completed, the PC may need to be restarted for the changes to take effect. If 
the check box to Reboot the computer is displayed, select the check box to restart your computer and 
click Finish. 
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Section 3

3 Printing preferences
All print driver operations and printing preferences are managed through the CPI Card Group - Spectrum Card 
Printer Printing Preferences. Accessing the printing preferences varies by Microsoft Windows operating 
system. For example, if you are running Microsoft Windows 10, the printing preferences are accessed by 
selecting Settings > Devices > HDP6600 Card Printer > Manage > Printing preferences.

All information is controlled through the File, Advanced, Encoding, and Utilities menu tabs. When you first 
access the preferences, the File menu is opened to the Basic Setup page. 

The File menu allows you to save and restore system settings, set up global printer settings, and establish 
printer setting profiles. 
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3.1 File menu tab
This tab allows you to view driver details and basic printer specifications. You can also restore driver default 
settings, save changes to your preferences, or discard changes before exiting the printing preferences. 

The File menu includes selections for the following pages and two exit options:

■ Basic Setup - Displays selections for printer settings, ribbon specifications, card type, and a link for 
restoring driver defaults.

■ Card View - Displays a representation of the currently selected card options. 

■ Help - Displays links to available help files and videos for the maintenance of the HDP6600 card printer.

■ Save Changes and Exit - Saves any changes made within the HDP6600 Card Printer Printing 
Preferences screens and exits the program.

■ Discard Changes and Exit - Cancels any changes made within the HDP6600 Card Printer Printing 
Preferences screens and exits the program.

■ Details - Displays the driver version number and ribbon color as well as the printer specifications for 
model, serial number, firmware, and card count. This information is displayed on all pages and menu 
tabs throughout the interface.
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3.1.1 Basic setup page
This page displays selections for printing on one or both sides of a card, card orientation, ribbon colors, and 
card types. It also includes a Details pane and a link for restoring the driver defaults.  

Field Definition

Single or Dual sided print job Defines whether to print on one side or both sides. If a dual-sided module is not 
detected, this selection is not available.
Selections available are: Print on One Side or Print on Both Sides.

Change Card Orientation Defines whether the card orientation is vertical or horizontal. 
Selections available are Landscape or Portrait.
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Ribbon Colors Automatically or manually select the colors that print. Options are: 
■ Auto Color: The system automatically selects the colors applied to the card

based on the ribbon type.
■ Auto Split: The system determines the most economical means of printing

a dual-sided card based on the ribbon type.
■ Manual Select: You can specify which colors are applied to a card side.

Card Type Specify the card type for optimal temperature and dwell settings. Options are:
■ FARGO® UltraCard® Premium (default card type)
■ FARGO UltraCard
■ FARGO UltraCard PC
■ HID Tech Card Composite
■ HID Tech Card PVC

Restore Driver Defaults Displays a prompt to reset all selections in the driver file to the default settings.
Click Yes to reset or No to cancel.

Field Definition
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3.1.2 Card view page
This page displays a representation of the currently selected card options.
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3.1.3 Help page
This page displays links to: 

■ Available help files for the printing preferences

■ Order printing supplies

■ Instructional videos for the maintenance of the HDP6600 card printer  

3.1.4 Exit options
To exit the Printing Preferences, choose one of the following:

■ Save Changes and Exit - Saves any changes made within the HDP6600 card printer printing 
preferences screens and exits the program.

■ Discard Changes and Exit - Cancels any changes made within the HDP6600 card printer printing 
preferences screens and exits the program.
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3.1.5 Details window
This window displays basic information about the driver and the printer connected to your PC. This 
information is also displayed on all pages and menu tabs throughout the interface.  

Field Definition

Details Displays the driver and printer information.
Driver:

■ Version: The installed printer driver version.
■ Ribbon: The detected ribbon color.
■ Mode: This is displayed if a dual-sided module is detected and if the card is set to flip 

before being printed. 
Printer:

■ Model: The printer model.
■ Serial Number: The serial number of the printer.
■ Firmware: The installed firmware version.
■ Card Count: The number of cards printed.
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3.2 Advanced menu tab
This tab allows you to select page setup options, printing options, diagnostic settings, and calibration 
settings.  

Page Setup

Menu option Description

Orientation Sets the card orientation. Select Portrait to print the card vertically. Select Landscape to print 
horizontally.

Duplexing Note: This option is grayed out if a dual-sided module is not detected.
Single Sided: Select this option to print only on one side of the card. This includes printing on 
the backside of preprinted cards that must have their magnetic stripe or smart card chip 
encoded.
Dual Sided: This option is used for cards printed on both sides. 
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Card Selects the type of card to print and optionally set up the card size and offset the print layout. 
Options are:
Type: Select the type of card to print:

■ FARGO UltraCard Premium (default)
■ FARGO Ultracard
■ FARGO Ultracard PC
■ HID Tech Card Composite
■ HID Tech Card PVC

More Card Settings: Opens the Page Setup window to define the card type and size.

Select a Card Type to print:
■ FARGO UltraCard Premium (default)
■ FARGO Ultracard
■ FARGO Ultracard PC
■ HID Tech Card Composite
■ HID Tech Card PVC

Select a Card Size:
■ CR-80: This is the default. This card printer accepts standard CR-80 sized cards

(3.41" x 2.165", 86.6 mm x 55 mm).
■ Custom: This selection is used to create a custom card size. Use the Print Width/Print

Height adjustment arrows to set the dimensions of the total print area for each card size.
Set the option for inches or mm.

Page Setup

Menu option Description
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Select the Layout tab to set the Offset Length and Offset Width for the image placement on 
the front and back of the card. 
Note: If Duplexing is set to Single Sided, the Back tab is not available on this window.

Adjust the image position values by clicking the Offset Length and Offset Width adjustment 
arrows. The image position changes according to the selection of portrait or landscape. 
Rotate 180 Degrees: Select this option to rotate the image on the front or back 180 degrees 
when printed.

Page Setup

Menu option Description
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Device Settings

Menu option Description

Image Transfer This setting controls the speed and temperature at which printed images are transferred from 
the film to the card. These settings may vary depending on the card type.
When the Use Defaults Based on the Film and Selected Card Type option is selected, the 
printer driver automatically optimizes these settings according to the card type and film type 
previously selected. Changes made to the Dwell Time and Temperature offset settings are 
saved for the selected card type option upon exiting the printer driver setup.

Dwell Time (seconds per inch): Sets the speed at which the printed image is transfered from 
the HDP film to the card in seconds per inch for each side of the card.

■ Lower limit = 1 second per inch
■ Upper limit = 3 seconds per inch

Temperature offset: Sets the temperature at which the printed image is transferred from the 
HDP film to the card.

■ Lower limit: -50
■ Upper limit: +15

Use Defaults Based on the Film and Selected Card Type: This option is automatically selected. 
The printer driver software has default temperature and dwell time settings that deliver the 
best transfer for these card types. These defaults are automatically configured, based on the 
card type, ribbon type, and whether printing single- or dual-sided.
Note: If you select the wrong option, the incorrect dwell time and temperature may be used 

during the image transfer process which results in poor adhesion of the HDP film or card 
warping.

Use Premium Mode: Select this option to reduce the transfer temperature and speed to 
enhance the image quality.
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Card Flattener This option is available only for single-sided card printing and is grayed out if a card flattener is 
not detected. Available options are:
Enabled: Select this option to enable the flattener.
Advanced Settings: This option is grayed out unless the Enabled option is selected. When 
selected, the Card Flattener window is displayed.

Temperature (Celsius): 
■ Lower limit: -50
■ Upper limit: +50

Dwell Time (seconds per inch): Sets the Dwell Time for the flattening process.
■ Lower limit = 1 second per inch
■ Upper limit = 3 seconds per inch

Delay (Seconds): Sets the Delay for the flattening process.
■ Lower limit = 0
■ Upper limit = 15

Use Defaults Based on Selected Card Type: This option is automatically selected. Clear this 
box to set the options in this window.
Note: If you select the wrong option, the incorrect dwell time and temperature may be used in 

the flattening process which may result in card warping.

Device Settings

Menu option Description
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Laminator This option allows control of the printer’s lamination process. When a laminator is not detected, 
the lamination option is grayed out. Available options are:
Front Side/Back Side: Specify the side of the card to laminate: 

■ No Lamination
■ Use Left LAM
■ Use Right LAM
■ First Available

More Settings: When selected, the Lamination window is displayed.

Lamination Mode
Front Side/Back Side: Specify the side of the card to laminate. Available options are:
■ No Lamination
■ First Available
■ Use Right LAM
■ Use Left LAM

Device Settings

Menu option Description
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Left/Right
Lamination Type: The type of laminate affects the temperature required for lamination. 
Available options are:
■ Clear Whole PolyGuard
■ Clear Whole UV Blocking PolyGuard
■ Holographic Orbit View PolyGuard
■ Holographic Whole PolyGuard
■ Clear Chip Cutout PolyGuard
■ Clear Chip Cutout UV Blocking PolyGuard
■ Holographic Chip Cutout PolyGuard
Lamination Position: Click the arrows to adjust the horizontal position of the laminate. The 
default is 0. The adjustment arrows point in the direction the patch moves on the card. The 
maximum horizontal value is 100 pixels (10 pixels=0.03 [0.8mm])
Lamination Temp offset: Available values are +/- 20.

Flatten Card
Enable: Select this option to enable the flattener.

Dwell Time (seconds per inch): Sets the Dwell Time for the flattening process.
■ Lower limit = 1 second per inch
■ Upper limit = 3 seconds per inch

Print Mode If Flip Card Before Print is selected, the reverse side of the card is printed first. 
Note: This option is available only for dual-sided card printing and is grayed out if a dual-sided 

module is not detected.

Device Settings

Menu option Description
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Print Image

Menu option Description

Ribbon Color This option allows the printer to automatically select the colors to print or allows you to specify 
card colors. This setting is determined by the ribbon detected in the printer and the selection 
of single- or dual-sided printing.
Auto Color: Automatically detects the ribbon type and splits the panel set when applicable. 
When Auto Color is selected, Manual Select is disabled.
Auto Split: If a dual-sided module is detected, prints YMCK on the front and K on the back.
Manual Select: Displays the Ribbon Colors window for you to select from the list of available 
colors. 

Select Image Colors
Front/Back: Available options are:
■ YMCK
■ YMC
■ K
Ribbon Type: Available options are:
■ YMCK
■ YMCKK
■ YMCKH
■ YMCFK
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K Resin Printing This option controls where the resin black (K) panel of a full-color ribbon is printed. Resin black 
text is desirable due to its sharp, saturated color. Available options are:
Dither Type:

■ Graphics
■ Photos

More Settings: This option is available when Ribbon Color is set to Auto Color or 
Manual Select. This option is only available with YMC-K panel combinations. This option opens 
the K Resin Printing window and provides the ability to:

■ Print black in image using K-panel resin (white background)
■ Print black in image using K-panel resin (color background)
■ Remove resin from image in selected area (keep out). See the Defined Areas option.
■ Print black in selected area of image. See the Defined Areas option.  

Use K Resin to Print Black in Images: Prints black in images using K-panel resin (white or color 
backgrounds) and automatically selects Print YMC under K Resin.
Print YMC under K Resin: Clear this check box to print black in image using K-panel resin 
(white or color backgrounds).
YMC Black Text (Default is K): This option prints black text with YMC instead of K.
K Resin Threshold in Images: When Use K Resin to Print Black in Images is selected, this 
option sets the K resin usage limit.

■ Lower limit = 1
■ Upper limit = 255

Default: Click this button to return the listed threshold to the factory setting.

Print Image

Menu option Description
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Use K Resin to Print Black in Images: Prints black in images using K-panel resin (white or color 
backgrounds) and automatically selects Print YMC under K Resin.
Print YMC under K Resin: Clear this check box to print black in image using K-panel resin 
(white or color backgrounds).
YMC Black Text (Default is K): This option prints black text with YMC instead of K.
K Resin Threshold in Images: When Use K Resin to Print Black in Images is selected, this 
option sets the K resin usage limit.

■ Lower limit = 1
■ Upper limit = 255

Default: Click this button to return the listed threshold to the factory setting.

Fluorescent This option is available when the YMCFK Ribbon Type is selected on the Ribbon Colors 
window. Available options are:
Invert Image: Causes light or white areas of the image to fluoresce and dark colors to remain 
dark on the printed card.
Dual-transfer: The fluorescing dye can be applied to a separate panel of HDP film. This 
enhances visibility.
Image on Next Page: Fluorescent print image is on the following page in the print job. This 
means the application must print an extra page. (For example, single-sided = page 2, 
dual-sided = pages 2 and 4).

Color Intensity Controls the overall darkness and lightness of the printed color.

Dye-Sub (YMC): This slider controls the overall darkness and lightness of the dye-sub printed 
image. Any adjustments only affect those images printed with dye-sublimation (YMC-type) 
ribbon panels.

■ Moving the slider to the left causes less heat to be used; the prints are lighter.
■ Moving the slider to the right cause more heat to be used; the prints are darker.

Resin (K): The heat is controlled for both front and back of cards. This control can be helpful 
for fine-tuning the sharpness of resin text and bar codes.
This slider controls amount of heat the printer uses when printing with the resin black panel.

■ Moving the slider to the left causes less heat to be used; the resin images are lighter or
less saturated.

■ Moving the slider to the right causes more heat to be used; the resin images are darker
or more saturated.

Default: Returns the listed percentages to the factory settings.

Color Correction Default: Sets the optimal and most accurate color setting for this device.
Legacy: Attempts to duplicate the HDP5000 color settings.
None: Uses the uncorrected output from the printhead.

Print Image

Menu option Description
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Defined Areas Adds and removes defined areas for K resin and color correction. 
Enable Defined Area: Select the type of area to add. Each defined area is represented by the 
following colors:
K Resin: 

■ Active: Gray
■ Keep Out: Cyan

Color Correction:
■ Active: Green
■ Keep Out: Yellow

Set Alignment PRN: Click this button to retrieve a saved print file to verify the defined 
locations on your card.
Add Area: Defines additional areas. Select K Resin or Color Correction from the drop-down 
list.
Resize Selected Area: Defined areas can be moved or re-sized by selecting the area and either 
dragging one of the handles to the desired size or by manually setting the horizontal, vertical, 
X, and Y coordinates.
To remove defined areas, select the area and press Delete. 

Print Image

Menu option Description
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3.2.1 Information panel
This panel is displayed on the left side of the Advanced, Encoding, and Utilities menu tabs. 

Field Definition

Media tab Automatically detects the materials in the printer such as the ribbon, film, and cards.

Ribbon Displays the reorder number, type, and remaining ribbon level detected.

Film Displays the reorder number, type, and remaining film level detected. 

Card Displays the card type and card size detected in the printer.

Configuration tab Displays any automatically detected features in your printer. Features are present when check 
boxes are selected. If communication with the printer does not exist, these configuration items 
can be manually selected. Available options are:

■ Card Flipper Module (dual-sided module)
■ Card Flattener
■ Magnetic Stripe Encoder
■ Smart Card Encoder
■ Laminator

Laminate tab This tab is displayed when Laminator is selected on the Configuration tab.

Left Displays the reorder number, type, and remaining laminate level detected.

Right Displays the reorder number, type, and remaining laminate level detected. 

Details Displays the driver and printer information. See Section 3.1.5 Details window for a description 
of these fields.
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3.2.2 Card image area
The card image area displays a representation of the card options currently selected. The options shown 
include card side, ribbon color descriptor, image transfer settings, defined areas legend (if specified), and 
single-sided or dual-sided print area images.

Field Definition

Front Side/Back Side Displays a single- or dual-sided card in a portrait or landscape orientation. This is determined 
by the selections made in the Page Setup area on the Advanced tab. If Single Sided is selected, 
this window displays all fields for Front Side. If Dual Sided is selected, this window displays all 
fields for Front Side and Back Side. 

Ribbon Color Displays the color descriptors for the card side. These are the detected ribbon colors. In 
addition, objects visually display how the ribbon is split (as shown in Advanced tab > Ribbon 
Color).

Image Transfer Displays any customized Image Transfer settings.

K Resin Printing Displays any defined K resin printing areas.

Print Direction Specifies the direction the card travels through the printer.
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3.3 Encoding menu tab
This tab contains the options for controlling the magnetic stripe encoding process. 

Field Definition

Configuration

Magnetic Encoder Setup Specifies magnetic encoder setup. Available options are: 
■ ISO (default)
■ Custom
■ JSII
■ Raw Binary
■ More Settings displays the Mag Encode window. 

See Section 3.3.1 Magnetic encoder setup configuration.

Diagnostics

Test Magnetic Encoder Tests magnetic encoder in the printer. See Section 3.3.4 Test magnetic encoder.

Test Smart Card Encoding Tests smart card encoder in the printer. See Section 3.3.5 Test smart card encoding.
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3.3.1 Magnetic encoder setup configuration
The Mag Encode window contains options for controlling the magnetic stripe encoding process. 

Field Description

Encoding Options Set the Encoding Mode and Coercivity or modify the ISO standards for Tracks 1, 2 and 3.
■ ISO Encoding: sends a formatted set of characters to the encoding module. The

magnetic track tabs are inactive and display ISO defaults for each track. This is the
default. See Section 3.3.2 ISO track locations.

■ Custom Encoding: all magnetic track options are active and can be changed.
■ Raw Binary Encoding: sends a raw binary string rather than a formatted set of

characters to the encoding module. Some magnetic track options are enabled.
■ JIS II Encoding: specific standards are used. The magnetic track tabs are inactive and

display JIS II defaults for each track.
Coercivity: Select the Coercivity option (Oersted [Oe]) for the Magnetic Stripe type for the 
Card Type.

■ Super High Coercivity = 4,000 Oe
■ High Coercivity = 2,750 Oe  (HID high coercivity UltraCard IIIs are 2750 Oe)
■ Medium Coercivity = 600 Oe
■ Low Coercivity = 300 Oe

Shift Data Left: This option shifts the recorded magnetic data to the left-hand side of the 
magnetic stripe on the card. This is used when cards require insert type readers.
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3.3.2 ISO track locations
The magnetic encoding module encodes onto tracks in accordance with an ISO/IEC 7811-2 magnetic stripe.

Magnetic Track 
Options

If these options are enabled, the user can specify how tracks are to be configured. All tracks 
display the same options.
Encoding Mode: Displays the encoding mode selected.
Character Size: Sets the character data size (bits per character) used to encode the magnetic 
data on the currently selected track.
Note: This character size includes the parity bit (if enabled).
When the drop-down list is enabled, selections vary for the selected encoding mode:

■ Custom encoding: 5 and 7 bits
■ Raw binary encoding: 4 and 8 bits

ASCII Offset: Sets the character ASCII offset used to encode the magnetic data on the 
currently selected track. Options are: NULL, SPACE, and ZERO.
Note: This character-offset value is subtracted from the ASCII value of each magnetic stripe 

data character prior to encoding on the track.
Bit Density: Sets the bit recording density (bits per inch) used to encode the magnetic data on 
the currently selected track. Options are: 75 and 210 BPI.
LRC Generation: Sets the LRC generation mode used to encode the magnetic data on the 
currently selected track. Options are: No LRC, Even Parity, and Odd Parity.
Character Parity: Sets the encoding mode used to encode the magnetic data on the currently 
selected track. Options are: No Parity, Even Parity, and Odd Parity. 
Reverse Bit Order: This option is used to reverse the character bits for the encryption of data 
in specific programs.
Add Leading Zeros: This option is used to add a set number of leading zeros to the magnetic 
string to move the starting point of the encoded data in specific programs for encryption of 
data.
Default: Resets defaults for the current track.

Field Description
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3.3.3 Sending track information
Magnetic track data is sent in the form of text strings from the application software to the printer driver.

The printer driver must be able to differentiate between magnetic track data and the rest of the printable 
objects, specific characters must be added to encode the magnetic data. These characters specify the data 
that is to be encoded, the tracks to encode, and marks the start and stop of the data string. 

In some cases, these specific characters are automatically added to the string of track data by ID software 
applications.

In most cases the user must carefully add these characters to the string of data. If these characters are not 
added to the track data, the text intended for the magnetic track appears as printed text on the card. To avoid 
this, track information must be entered as described here.

When entering track data, the ~ (tilde) character is entered first, followed by the track number (1, 2 or 3) on 
which the data should encode. This is followed by the data to be encoded.

The first character of this data string must be the track's specific Start Sentinel (SS) and the last character 
must be the specific End Sentinel (ES).

The characters or data in between the SS and ES can include all of the valid characters specific to each track.

■ The number of these characters, however, is limited by each track's maximum character capacity. 

■ When segmenting track data, the appropriate Field Separator (FS) must be used. The ASCII code and 
character table shows the SS, ES, FS and the valid characters defined for each track.

Reviewing the sample string
Track 1: ~1%JULIEANDERSON^1234567890?

Track 2: ~2;1234567890987654321?

Track 3: ~3;1234567890987654321? 

ASCII code and character table

Track Start 
Sentinel

End 
Sentinel

Field 
Separator

Valid Characters Maximum Number of 
Characters

Track 1 % ? ^ ASCII 32–95 (See the table) 78

Track 2 ; ? = ASCII 48–63 (See the table) 39

Track 3 ; ? = ASCII 48–63 (See the table) 106

ASCII Code Character ASCII Code Character ASCII Code Character

32 space 54 6 76 L

33 ! 55 7 77 M

34 56 8 78 N

35 # 57 9 79 O

36 $ 58 : 80 P

37 % 59 ; 81 Q

38 and 60 < 82 R

39 ‘ 61 = 83 S
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40 ( 62 > 84 T

41 ) 63 ? 85 U

42 * 64 @ 86 V

43 + 65 A 87 W

44 ‘ 66 B 88 X

45 - 67 C 89 Y

46 . 68 D 90 Z

47 / 69 E 91 [

48 0 70 F 92 \

49 1 71 G 93 ]

50 2 72 H 94 ^

51 3 73 I 95 _

52 4 74 J

53 5 75 K

ASCII Code Character ASCII Code Character ASCII Code Character
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3.3.4 Test magnetic encoder
Exercises the printer’s magnetic encoding functionality independent of image or application. 

Field Description

Encode Track Data Magnetic Track Data:
■ Track 1:
■ Track 2:
■ Track 3:

Sentinels:
■ Start:
■ End:

General Sample Data:
Encode:
Print encoding information on card:

Read Track Data Feed Card into Encoder:
Read Buffered Data:
Eject Card:
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3.3.5 Test smart card encoding
Provides the ability to test the smart card encoder in the printer. 

Field Description

Check SAM Firmware 
Compatibility

View installed technology Available options are:
■ PROX
■ iCLASS/iCLASS SE
■ MIFARE
■ Contact Smart Card
■ Seos
■ DesFire

Dock Card to Reader Select this link to instruct the printer to dock the card to the magnetic encoder.

Eject Card Select this link after the test has been performed to eject the card from the printer.

Connection Select the type of encoder from the list.
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Test Select the test you wish to run. Available options are:
■ Perform Reader Test
■ Get Vendor Name
■ Get Vendor IFD Version
■ Get Vendor IFD Type
■ Get Reader System Name
■ Get Reader Friendly Name
■ Get Reader Max Data Rate

Click Run Test to perform the test.

Automatically Scroll Select this box to allow the test results in the status window to automatically scroll as 
new information is obtained.

Clear Results Select this link to clear the test results in the status window.

Field Description
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3.4 Utilities tab
This tab provides several maintenance, diagnostic, and configuration settings for your printer. 

Field Definition

Maintenance

Clean Printer Specifies how to clean the printer using a cleaning card. 

Calibrate Sensors Specifies how to calibrate the ribbon and film sensors. 

Update Manager Checks, manages, and downloads updates for printer firmware and drivers. 

Diagnostics

Test Print Sends sample cards to the printer using the current driver settings.

Self Tests Sends commands to activate on-board self-tests in the printer.

PRN Viewer Views a print file (PRN) as an image or send the file to the printer.

Color Assist Create swatches of sample colors that can be printed and used for color matching.

Configuration

Internal Printer Settings Modifies settings stored in the printer.

Driver Defaults Saves and restores printer instance default settings.
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3.4.1 Clean printer
Follow the instructions on the page to clean the printer. The cleaning routine begins after all current print jobs 
have completed.

The CardPath option sends the cleaning routine to the printer. Follow the instructions on the page to clean 
the card path.

The Film Roller option sends the cleaning routine to the printer. Follow the instructions on the page to clean 
the film roller. 
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The Laminator option sends the cleaning routine to the printer. Follow the instructions on the page to clean 
the laminator. 
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3.4.2 Calibrate sensors
The Calibrate Ribbon option sends the calibrate ribbon command to the printer. Follow the instructions on 
the page for calibration of the ribbon sensor.

The Calibrate Film option sends the calibrate film command to the printer. Follow the instructions on the 
page for calibration of the film sensor. 
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The Calibrate Laminator option sends the calibrate laminator command to the printer. Follow the instructions 
on the page for calibration of the laminator sensor. 
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3.4.3 Update manager
This selection allows you to check, manage, browse, and download updates for printer firmware and drivers. Each update 
is identified by product, version, status, and download progress. 

Field Description

Check for updates Click this link to check for any available firmware and printer driver updates. 
Available updates are displayed by product, version, status, and download 
progress.

Browse Updates Folder Opens a window to browse the updates folders stored on your PC or available 
network.

Update Printer Firmware tab Lists available HID printers connected to your computer.

Firmware Update Process Describes the steps to update your printer firmware.

Select firmware file Opens a window to browse for saved firmware files.

Begin Updating Firmware Click this button to begin updating the firmware on the selected printer.
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3.4.4 Test print
Print a sample card based on the selected settings. 

Field Description

Front Click and drag a sample card from the left side of the screen to the card outline on the right 
side of the screen. Cards images can be changed by dragging additional sample cards to the 
existing image. If a dual-sided module is detected, a Back card outline is displayed. Card 
images are displayed according to the orientation set on the Advanced tab.

Print Once a sample card is selected, click this icon to print the sample card. If the Print To File 
check box is selected, this option opens a new window to specify the file location and file 
name.

Print To File Saves the sample card image as a .prn file.

Copies Sets the number of sample cards to print. Use the arrows to specify the number of cards to 
print. Available values are 1-99.

Show Text Select this option to display Some Sample Text at the top of the sample card. When this 
option is selected, the Font, Color, and Size options can be adjusted.
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3.4.5 Self tests
Provides the ability to run control feature commands resident in the firmware to exercise motors and sensors in the 
printer. These tests allow you to isolate printer functions and run them to determine operational status. 

Font Changes the font of the sample text on the card. This field is available when the Show Text 
option is selected. 

Color Changes the color of the sample text on the card. This field is available when the Show Text 
option is selected.

Size Changes the font size of the sample text on the card. This field is available when the Show 
Text option is selected.

Field Description

Poll for Sensor Status When selected, each sensor is checked at the interval specified by the Polling Interval: 
(sec.) field. 

Update Display When selected, the Printer Display Panel reflects what is shown on the printer display. 

Polling Interval: (sec.) Sets the number of seconds to wait before each check of the printer status. Available 
values are 1 to 30 seconds.

Field Description
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Sensor/Value Shows the list of printer sensors and their default values.

Printer Display Panel Shows the current printer display. This window updates as the printer status changes.

Mechanical Tests Lists the available mechanical tests. 
■ Raise the Printhead
■ Lower the Printhead
■ Home the Flipper Table
■ Ribbon Sensor Calibration (Remove Ribbon)
■ Advance the Stepper Motor (Remove Cards)
■ Reverse the Stepper Motor
■ Run Ribbon Take-up Motor (Remove Ribbon)
■ Run Ribbon Supply Motor (Remove Ribbon)
■ Run Printhead Lift Motor
■ Calibrate the Film Sensors
■ Restart the Printer
■ Cycle the Transfer Head Lift Motor
■ Run Film Supply Motor (Remove Film)
■ Run Film Take-up Motor (Remove Film)
■ Advance Laminator Steppers
■ Disengage Laminator Head
■ Home Laminator Flipper
■ Invert Laminator Flipper
■ Reverse Laminator Steppers
■ Rotate Laminator Landscape
■ Rotate Laminator Portrait

Self Tests Lists the available tests.
■ Alignment Self Test
■ Device Settings Self Test
■ Resin Self Test
■ Color Photo 1
■ Color Photo 2
■ Laminator Self Test

Run Test Click this link to run the selected mechanical or self test.

Field Description
July 2019 73



Printing preferences PLT-02931, Rev. A.1
3.4.6 PRN viewer
The PRN viewer provides the ability to view a print file (PRN) as an image. You can send print files to the 
printer to view proper layout, determine if image defects are part of the file going to the printer, and verify 
the printer driver settings are the same as the PRN file. You can also print copies of these for samples or 
troubleshooting.

Field Description

PRN

Select File Click this button to browse for any saved printer file on your computer. The path and filename 
are displayed above the file image.

Send to Printer Click this button to send the file to the printer.

Color Planes

Side 1/Side 2 Open the menu to view each color plane for this card to determine if there are any image 
defects.

Save Image Click this button to save any of the color planes as .bmp files.
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3.4.7 Color assist
Opens the Color Assist tab to define the RGB values to accurately depict the colors to print on your cards. 

Field Description

Palette

Reset Palette Resets your palette for new or future work.

Generate Gradient

Saturation Adjusts the intensity of the color. As the saturation increases, the colors appear more pure. 
As the saturation decreases, the colors appear more washed out gray.

Luminosity Adjusts the brightness with a scale of white to black.

Generate Click this icon to create the color gradient of the swatches based on the Saturation and 
Luminosity selected.

Swatch Management

Add Color to Swatches Click this icon to add the selected color to the visual list of color swatches.

Remove Swatch Click this icon to remove the selected color from the visual list of color swatches.
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Printing

Current Color
Selected Swatches
All Swatches

Select one of these options to print:
Current Color: Prints the currently selected color swatch.
Selected Swatches: Allows you to select multiple swatches from the visual list.
All Swatches: Selects all the swatches in the visual list.

Print Prints the color swatches according to the selected option.

Field Description
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3.4.8 Internal printer settings
Use this option for adjusting the internal printer settings. These settings have been customized for the printer 
at the factory. These printer settings are HID advanced settings based on Electrically Erasable Programmable 
Read-Only Memory (EEPROM). 

Note: Any changes affect the settings for the firmware. 

To change a setting, click the Edit Settings link. In the value column, change the numeric value in the row. 
When all updates are correct, click the Save Settings link.

Field Description

Name Displays the label for each setting.

Value Displays the current value for the setting.

Default Displays the factory default value for the setting.

Min Displays the minimum value available for the setting.

Max Displays the maximum value available for the setting.

Refresh Settings Click this link to refresh the values.

Edit Settings
Save Settings

This link toggles between editing and saving. Click this link to edit the settings in the Value 
column. When all updates have been made, click the link again to save your updates.
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3.4.8.1  Printer settings

Setting Description

Head Resistance This is factory set. If the main board or the printhead is replaced, then adjust this 
number. Locate the printhead setting number on the bottom of the printhead. The 
number reads: R=XXXX. 

Print Left Of Form Prints the alignment self-test card.
Adjust the Print Left of Form up or down until the border of the left of form zero 
line is showing on the edge of the card.
Measure the density square. Adjust the image density to 65% ± 1%.

Image Darkness Use this option to set the overall darkness of the printed image by increasing or 
decreasing the amount of heat the printhead uses while printing. 
Use the up and down arrows to increase or decrease the amount of heat.
Important: If the value is set too high, the ribbon may jam or break.

Print Top of Form Print the alignment self-test card.
Adjust the Print Top of Form until the green border is eliminated and the entire 
transfer alignment block is as shown in the bottom graphic
Note: Due to variation in roller alignment, the green border may appear at a slight 

angle on the top of the card.

Edge of transfer
(green border)

Transfer alignment block

Image once adjusted
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Mag Top of Form This option is only for the built-in magnetic stripe encoder. 
Use this option to shift the starting point of where the printer begins encoding the 
magnetic track data on a magnetic stripe of the card.
When adjusting this value, keep in mind that a card and its magnetic stripe always 
remains in the same relative position as the card travels through the printer.
Magnetic Data Direction
The arrows on these buttons indicate the direction the magnetic data moves on the 
magnetic stripe on the card.
Enter a positive value to move the start of the magnetic data toward the trailing 
edge of the card or the card input side of the printer.
Maximum Adjustment Range
The maximum adjustment range is 0–120. As a rule, 20 equals .030” (0.8 mm).
Note: If the negative value is set too high, the printer may start encoding before the 

magnetic stripe on the card reaches the encoding head. 

Transfer TOF Print the alignment self-test card.
Adjust the Transfer TOF until the TOF zero line is located on the edge of the card. 
If the Transfer TOF is made too negative, the transfer roller can engage in front of 
the card causing a transfer jam. 

Setting Description
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Transfer EOF Print the alignment self-test card.
Setting the Transfer EOF to a positive number causes the image length to grow.
Setting the Transfer EOF to a negative number causes the image length to shorten. 

Transfer Temp Offset Both the printer and the printer software driver control the built-in transfer roller.
To change the temperature of the transfer roller, adjust the temperature through the 
Image Transfer selection within the Advanced tab of the printer preferences. Once 
adjusted, the new temperature setting is sent down with the next print job along 
with the rest of the printer driver information.
Before printing begins, the transfer roller automatically adjusts to the new 
temperature setting. This new temperature setting remains programmed within the 
printer until it is once again changed within the printer driver or until the printer is 
turned off.
Whenever the printer is turned OFF, the transfer roller automatically resets and 
returns to the default temperature the next time the printer is turned ON. 
Disconnect the printer power supply.
Technician Note: Cycling the printer power supply serves to reset the transfer roller 
to its default temperature. The temperature setting within the printer driver, 
however stays the same until it is changed.

DANGER: The printer transfer roller can reach temperatures exceeding 350°F 
(175°C). Use extreme caution when operating the transfer roller. Never 
touch the transfer roller unless the printer power has been turned off 
for at least 20 minutes.

DANGER: Le rouleau de transfert de l'imprimante peut atteindre des 
températures supérieures à 350°F (175°C). Soyez extrêmement 
prudent lorsque vous utilisez le rouleau de transfert. Ne touchez 
jamais le rouleau de transfert à moins que l'alimentation de 
l'imprimante a été éteint pendant au moins 20 minutes.

Encoder Flip Angle Use this setting to fine tune the position of the flipper. 
Note: Only used if encoder is present.

Print Flip Angle Use this setting to fine tune the home position of the flipper if cards have difficulty 
moving from the printer into the flipper. 

Print Flip Level Use this option to set the position of the flipper so it is level with the card path after 
a flip operation.

Ribbon Print Take-up Tension This controls the tension of the color ribbon during printing. Adjust the ribbon 
tension if ribbon wrinkle is appearing on the card. 
Note: Adjustments moderately change the image length.

Ribbon Print Supply Tension This controls the supply side tension of the color ribbon during printing. Adjust the 
ribbon tension if ribbon wrinkle is appearing on the card. 

Setting Description
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Film Stretch Compensation When printing, the position of the image on the film can vary depending on whether 
the previous film panel is used or not. Adjust this setting if the first card after an 
error is shifted from the rest. 

Alternative Mag Verify If set to 1, enables a quicker mag verification step of just looking for any data 
encoded on the card. If set to 0 verifies all data written to the card. 

Mag Hico DAC Adj Fine tunes the mag drive current for high-coercivity/super coercivity cards. Adjust if 
mag verify errors start occurring with new card stock. 

Mag Loco DAC Adj Fine tunes the mag drive current for low-coercivity/medium-coercivity cards. Adjust 
if mag verify errors start occurring with new card stock. 

Resin Heat Adjust Print the resin self-test card. 
Use this adjustment for black resin text and barcodes that appear faded or too light 
or dark.

Sleep Time Heater Off This setting adjusts how many minutes after the printer goes idle or enters a low 
power state that the printer goes into a heater off power state. 

Sleep Time Heater Low Power This setting adjusts how many minutes after the printer goes idle, the printer goes 
into a low power state. 

Blush Point The blush point is compensation during printing:
■ There is no dye transfer.
■ There is no light gray line on a portion of the card.
■ It should be white.

Film Takeup Transfer Tension ■ Negative adjustments can cause card jams.
■ Positive adjustments can help stop jamming.

Note: Adjustments affect flash and smudge.

Film Print Supply Tension Important: The film drive sets the baseline for the film tension and should not be 
adjusted by the reseller or the end user.

Note: Adjustments moderately change the image length.

Cleaning Rate This adjustment changes the cleaning rate from 2000 to the new setting. 

Transfer Heat Dissipation Level This setting adjusts when the transfer fan turns on. 
■ 0, 1, and 2 - Transfer fan is on only during transfer.
■ 3 - Transfer fan turns on when transfer roller comes up to temp.
■ 4 - Transfer fan always on when not in sleep mode.

EAT Disable Environmentally Adaptive Transfer (EAT) automatically adjusts the transfer 
temperature based on the ambient air conditions within the printer.
This is an ON (1) or OFF (0) switch. 
Note: Settings can increase or decrease the transfer roller temperature by as much 

as 68°F (20°C) in extreme conditions.

Beep Disable This setting disables the beep the printer generates after an EE setting is updated. 

eSTANDBY_TEMP This option changes the temperature used when the printer is in standby mode. 

Flipper Offset Mag This setting fine tunes the position of the flipper relative to the mag encoder. Only 
use if a mag encoder is installed. 

Image Length Fine tunes the length of the image on the card. Increase this value if the image 
length is too short. Decrease this value if the image length is too long. 

Internal Encoder offset in mm Fine tunes the position of the card when docking into Bay 0. 

Setting Description
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3.4.8.2  Laminator settings

Flattener TOF offset Adjusts the position of the card when the flattener roller engages. 

Job Canceling Timeout Period Slower PCs can have difficulty canceling all print jobs. Increase this value if all print 
jobs do not get canceled and instead some restart printing. 

Ribbon Queueing Position 
Offset

Fine tunes the position of the ribbon prior to printing. Adjust if printing starts in the 
previous panel or goes off into the next panel. 

Mag Verify If set to 1, enables verification of encoded mag data. 

Setting Description

Lam Rotator Card Position Offset Position of the card on the rotator. 1 = .0014 inches.

Lam Rotator Portrait Offset Angle of the rotator in the portrait position. 1 = 1°

Lam Rotator Landscape Offset Angle of the rotator in the landscape position. 1 = 1°

Lam Flipper Home Offset Flipper angle at the home position (plastic pinch rollers facing up). 1 = .75°

Lam Flipper Inverted Offset Flipper angle opposite the home position (rubber driver rollers facing up) 
1 = .75°

Setting Description
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Lam Flipper Card Position Offset Position of the card on the flipper table. 1 = .0076 inches.

Lam Right Full Card Top Of Form Controls the card’s leading edge position relative to the hot roller. 1 = .0014 
inches.

Lam Right Laminate Top Of Form Controls the right side lam patch leading edge position relative to the card. 
1 = .0014 inches.

Lam Right Full Card End Of Form Position of the end a lamination. 1 = .0014 inches.

Lam Right Half Card End Of Form Position of the end of a half patch lamination. 1 = .0014 inches.

Lam Left Full Card Top Of Form Card’s leading edge position relative to the hot roller. 1 = .0014 inches.

Lam Left Laminate Top Of Form Controls the right side lam patch leading edge position relative to the card. 
1 = .0014 inches.

Lam Left Full Card End Of Form Position of the end a lamination. 1 = .0014 inches.

Lam Left Half Card End Of Form Position of the end of a half patch lamination. 1 = .0014 inches.

Lam Standby Temperature Hold temperature between jobs. 1 = 1° C.

Lam Sleep Time Time in minutes before going to sleep. 1 = 1 minute.

Lam Whole Patch Speed Patch speed (tension) during lamination. 1 = 1 step/sec.

Lam IC Cutout Patch Speed IC Cutout patch (tension) speed during lamination. 1 = 1 step/sec

Lam Flatten TOF Adjusts the position of the card when the flattener roller engages the card. 
1 = .0014 inches.

Lam Flatten EOF Adjusts the position of the card when the flattener roller disengages from the 
card. 1 = .0014 inches.

Enable Lam Registration Pass Enable registration pass for card.

Setting Description
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3.4.9 Driver defaults
This setting allows you to save the current settings for this printer instance as the default. The settings can be 
saved to a file and be applied to other printer instances of the same printer model.  

Field Description

Save Defaults Click Save to make the current settings the system default for this printer instance. 
If you want to save these settings to a file.

1. Select the check box and click Save. 
2. At the prompt to confirm this action, click Yes.
3. Select a file location and name the file. Click Save.

Restore Defaults Allows you to open a saved system default file and apply it to the selected printer. The 
printers must be the same model.
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4 HID Printer Status Monitor
The HID Printer Status Monitor displays information about your card printer print jobs. During the installation 
of the printer driver, you were prompted with the recommended option to install the HID Printer Status 
Monitor.

After installation, the Status Monitor is set to launch on start up. It can be accessed through a short cut in 
your startup folder or an icon in the notification area (which may be hidden). To make the HID Status Monitor 
icon be more visible on your PC, you can pin it to your taskbar or use the Windows settings to always show 
the icon on the taskbar.

Features of the Status Monitor include enabling and customizing desktop notifications, saving or opening a 
system log event, canceling a print job, and submitting a technical support case.

The Status Monitor can monitor all printers that are connected to your PC, either through a network 
connection (Ethernet) or through a USB cable. The printers are shown in a folder structure also known as a 
device tree with groups of printers at the top level and printer instances in subgroups. Each node and each 
instance can be configured and monitored.
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4.1 Configuration tab
This tab allows you to set up how you are notified of print job statuses per printer instance. 

You can select either the printer node or the printer instance in the device tree. If you select the printer node 
on the left side of the screen, any changes to the selections on the Options tab on the right side of the screen 
affect all instances of that printer type. If you select the individual printer instance, you can modify the 
options individually.

Field Description

Alert Options Specifies how notification of alerts are displayed. Options are:
Desktop Message: Displays a small window on the right left side of the main screen.
Icon Alert: Displays an icon in the task bar. When an alert is active, the icon blinks.

Message Settings Sets the characteristics of the desktop message. Settings are:
Duration: Sets the amount of time the error message is displayed on your screen when 
an error occurs. Available setting is 3-30 seconds. Default is 3 seconds.
Transparency: Sets the background color of the message displayed on the screen. 
Values available are 0-80%. If set to a lower number, the background of the message 
window is more opaque. Default is 50%.
Preview message: Displays the desktop message using the currently selected 
settings.

Printer This selection is displayed when the Active Jobs tab is displayed. 
Cancel All removes all jobs waiting in the print queue area.

Save Saves the selected options for this printer instance.
Save: Saves the settings that are currently set.
Save And Exit: Saves the settings and closes the HID Printer Status Monitor.
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4.2 System event log tab
This tab lists all of the printing events (error, warning, information, or password) since the last time the log has 
been cleared. The event log can be saved as an EVTX file that can be viewed with the Windows Event Viewer. 
The system event log is a good way to send information to HID Technical Support. 

Field Description

Log Saves the current log file or opens a saved log file. Options are: 
Save As: Opens a new window to choose the location to save the event log.
Open Saved Log: Open a new windows to browse to the location of the saved event log.

Refresh Updates the system event log and redisplays the current log information.

Clear Removes all entries in the system event log. To clear the log, you may be prompted to 
re-launch the Status Monitor with administrator privileges. 
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4.3 Support tab
This tab shows the options for obtaining help with the Status Monitor application. 

Field Description

Help Opens a link to the online help file.

About Opens a window that displays the print driver version and copyright information for 
the HID Status Monitor.

Technical Support Opens a link to HID Technical Support to submit a technical support case.
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5 Ethernet option

5.1 Introduction
The Ethernet option for the CPI Card Group - Spectrum High Definition Card Printer/Encoder includes the 
Ethernet port and the internal printer server. 

Printer Management: The printer driver provides bi-directional status information so you can monitor and 
manage the printer just as you would any other networked printer. 

Compatibility: The Ethernet option provides compatibility with TCP/IP and 802.3 Ethernet protocols with 
an IEEE 802.3 10/100 Base-T Ethernet female RJ45 connector. 

Application: The Ethernet Option applies to the card printer/encoder. With the Ethernet option properly 
installed and configured, these printers are able to print in the same manner as a printer directly 
connected to the PC using a USB interface.

Note: Any reference to a specific printer name is for demo purposes only. Your printer name varies according 
to what you are using. 

5.2 Technical specification
The system requirements for Ethernet are as follows: 

Caution: For safety purposes, Ethernet is not intended for a direct connection outside the building.

Function Requirement

Network An IEEE 802.3 10/100 Base-T Ethernet network is required.

Printer A printer with the Ethernet option installed is required.

Printer configuration Since TCP/IP is used for the network communication, the printer must be configured with an 
IP address and a subnet mask (before it can be seen on the network). 
An additional network setting for the default gateway can also be configured, which allows 
communication across the subnets.
Dynamic Host Configuration Protocol (DHCP) is also supported for auto configuration.
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5.3 Functional specification
The Ethernet option includes the following features.

Host computer ■ Windows 7 (32- and 64-bit)
■ Windows 8 / 8.1 (32- and 64-bit)
■ Windows 10 (32- and 64-bit)
■ Windows Server 2008 R1 (32- and 64-bit)
■ Windows Server 2008 R2 (64-bit only)
■ Windows Server 2012
■ Windows Server 2012 R2 
■ Windows Server 2016 

Host printer driver The host PC must have installed the correct printer driver with Ethernet support. 
Note: This driver must be configured for printing to the IP address of the printer.

Feature Description

Simultaneous printing Print simultaneously from multiple PCs to the network printer.

Printer feedback Status information from the network printer to the PC.

Web pages Easy printer configuration with any web browser.

Password security Provides password security for admin user only.

SNMP Provides an SNMP (Simple Network Management Protocol) agent that supports MIB-II 
(Management Information Base, second version).

Upgrades Support for firmware upgrades over the network.

Troubleshooting Provides a Ping client for network troubleshooting.

SSDP Simple Service Discovery Protocol (SSDP) is used to find the printers with an Ethernet 
connection on a local network.

Function Requirement
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5.4 Network services
The Ethernet option provides the following services:

■ Print server

■ Web server

Note: Other services include a Ping client, address assignment, and printer discovery.

5.4.1 Print server
The print server provides printing services via the local area network (LAN) to the client PC (in the same way 
as a printer connected directly to a USB interface). The print server must be properly configured to provide 
this printing capability.

■ The print server can queue up to eight client PCs while printing. Communications between each PC and 
the printer are implemented over a bi-directional TCP/IP interface. 

■ All clients are able to send print jobs to the printer and monitor printer jobs and errors with the 
standard Windows printing system using the printer driver installed on their local PC. 

Therefore you know whether or not a print job has been successful, as well any problems that have been 
encountered while processing the print job. 

5.4.2 Web server
An HTTP service serves web pages that are the interface through which to configure the printer.

The printer operates as a Simple Network Management Protocol (SNMP) agent to allow a network 
administrator to support the network interface of the printer. 

Note: A standard host MIB-II is implemented to maximize the utility of the printer on the network.

5.5 Ethernet web pages
Use the Ethernet web pages from your Ethernet-connected printer to view attributes about the printer. To 
alter settings of the printer, you must have administrative rights confirmed by entering a valid user name and 
password.

5.5.1 Accessing the home page
1. Open a window for your network browser application on your local PC. 

2. Find the IP address of the printer. See Section 5.6.1 Accessing the IP address of the printer on how to 
retrieve this information from the printer display.

3. Enter “http://” and the IP address of the printer you want to access into the address bar of the browser. 

Note: The IP address changes for your printer installation.  

4. Press Enter.

The Home page is displayed.
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5.5.2 Home page
The Home page displays general information about the printer. 

Field Description

Printer Information

Serial Number Displays the unique fixed serial number of the printer.

Firmware Version Displays the current firmware version.

Hardware Address Displays the unique fixed hardware address (MAC) of the printer, which is the unique 
Ethernet device identifier.

IPAddress Internet protocol address.

IPV6Address Internet protocol address.

Supply Information

Ribbon Print ribbon. Information includes: Type, Part Number, and Percent Remaining.

Intermediate Film HDP film. Information includes: Type, Part Number, and Percent Remaining.

Change Printer IP Address Accesses the Network Settings to view or modify the current network settings. See 
Section 5.5.4 Configuring the network settings.

Preferences Accesses the Preferences settings. See Section 5.5.5 Preferences.
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5.5.3 Changes to the settings
When you change any setting, you may need to confirm your administrative rights by entering the user name 
and password. You may also need to restart the printer to continue.

Note: The windows displayed for the user name and password varies by the browser you are using. The 
information to input into the fields is the same. This example shows Google Chrome.

1. Enter the correct user name. The default user name is “root”.

2. Enter the password: The default password is blank.

To change the password, see Section 5.5.5.1 Change password.

3. Click Sign In. 

4. If the user name and password is not accepted, another login prompt is displayed on the screen. Repeat 
this procedure with the correct user name and password.

5. The Confirm window is displayed. Click Restart Printer. 

A notification is displayed as the printer is restarted.
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5.5.4 Configuring the network settings
Select the Network Settings tab. The Network Settings page displays the current network settings. 

Field Description

TCP/IP Modify the network communications using the transmission control and internet protocol 
(TCP/IP) settings.

SNMP Enables or disables the simple network management protocol (SNMP) and modify settings

Discovery Enable or change device discovery settings.
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5.5.4.1  TCP/IP settings
1. Select the TCP/IP link to display the current TCP/IP network settings.

2. Make any necessary changes and click Save. 

Note: You may need to confirm your administrative rights by entering a valid user name and password. 
You may also need to restart the printer to save any changes. See Section 5.5.3 Changes to the 
settings.

Field Description

IPv4 Sets either a dynamic host configuration protocol or maintains a permanently assigned 
IP address for the HDP6600 card printer network parameters. Available options are: 
DHCP or Static.

IPv6 Sets the IPv6 address automatically, maintains a permanently assigned IP address, or 
disables the IP address for the HDP6600 card printer network parameters. Available 
options are: Disable, Auto, and Static.

General Sets the domain name system (DNS) name, port number, and an automatic or 
permanently assigned DNS server address. Available fields are Host Name, Port 
(required), and DNS options: Auto or Static.
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5.5.4.2  SNMP settings
1. Select the SNMP link to display the current SNMP network settings.
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2. Make any necessary changes and click Save.

Note: You may need to confirm your administrative rights by entering a valid user name and password. 
You may also need to restart the printer to save any changes. See Section 5.5.3 Changes to the 
settings.

Field Description

SNMP Settings Enable or disable simple network management protocol (SNMP). Select the version you 
wish to use. Available options are SNMP v1/v2c and SNMP v3. Also specify the UDP Port 
Setting.

SNMP v1/v2c Enter the Read Community Name and the Write Community Name for the SNMP v1/v2c 
setting.

SNMP v3 Enter the Read User Name/Write User Name, Security Level, auth-password, and 
priv-password for the SNMP v3 settings.

Device Enter the Location, Contact, Encryption Algorithm, and the Authentication Method for 
this device.
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5.5.4.3  Discovery settings
1. Select the Discovery link to display the current device discovery network settings.

2. Make any necessary changes and click Save. 

Note: You may need to confirm your administrative rights by entering a valid user name and password. 
You may also need to restart the printer to save any changes. See Section 5.5.3 Changes to the 
settings.

Field Description

Device Discovery Turns device discovery on or off.
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5.5.5 Preferences
The Preferences can be accessed from any of the pages of the interface. Using the Preferences page, you can 
change your web interface log in password and your language selection.
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5.5.5.1  Change password
1. Click the Password link. 

The Change Web Interface Password window is displayed. 

2. Enter a new password. This field is required.

3. Re-enter the new password to confirm. This field is required.

4. Click Save.

Note: You may need to confirm your administrative rights by entering a valid user name and password. 
You may also need to restart the printer to save any changes. See Section 5.5.3 Changes to the 
settings.
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5.5.5.2  Language selection
1. Click the Language Selection link. 

The Language Selection window is displayed. 

2. Select a language.

3. Click Save.

Note: You may need to confirm your administrative rights by entering a valid user name and password. 
You may also need to restart the printer to save any changes. See Section 5.5.3 Changes to the 
settings.
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5.6 Troubleshooting
If you are having trouble connecting to your Ethernet printer or printing to it, you should go through each of 
the following procedures.

5.6.1 Accessing the IP address of the printer
The additional printer display menus for an Ethernet-enabled printers are provided to view its IP address. 
Follow these procedures to access the IP address of your printer.

1. Switch on the printer.

2. Ensure the printer is connected to the network.

3. Wait up to one minute to allow the printer to configure the IP address.

4. On the printer display, select  > Info.

5. Scroll through the messages until the IP address is displayed as a dotted quad number, i.e. 168.192.1.1.

5.6.2 Verifying the printer connection
1. Ensure the printer has a valid network connection.

2. Verify that the printer has the green LED on solidly and that the amber LED is flashing with network 
activity.

3. If the LEDs do not indicate connection, verify the network connection with another device. 

4. If the connection is OK, then something may be wrong with the Ethernet option installation. 

5.6.3 Verifying the printer IP address
1. Check the printer display for a valid IP address (0.0.0.0 is not valid). 

■ If the IP address is valid, go to Step 4. 

■ If the IP address is not valid go to Step 2.

2. If your network is using DHCP, then verify that the printer has not been configured to use a static 
address (unless you have a known, unused static IP address assigned to the printer).

3. If you are using a static IP address, verify that there is no other device using the same address by 
removing your printer and sending a ping to the desired address. 

4. If any device responds, then you must find a different available IP address.

5. If the printer reports an IP address, verify that it matches subnet of the network where it is connected. 

6. If your printer has DHCP disabled, then the static IP address may have been previously set for a 
different subnet.
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5.6.4 Verifying that the PC can access the printer using the ping command
Follow these instructions to issue a ping command to the printer.

1. At a Command Prompt window, enter “ping [IP address]”: 

For example: C:\>ping 10.244.69.144

2. A successful ping response is shown here:

3. If the response is successful, move on to the next troubleshooting procedure. 

4. An unsuccessful response is shown here:

5. If the ping response is not successful, continue to Step 6.

6. Verify that the PC and the printer are connected to the same network.

7. You may be on different subnets of your network and some of the network settings for the printer are 
not correct. See your network administrator for additional assistance. 

Note: The subnet mask must be the same as other devices on the network, and the unique IP address 
must be part of the network specified by the subnet mask.

5.6.5 Printing a test page
Try printing a test page from the printer driver properties window. 

If you cannot print a test page, then consider the following possibilities:

■ There may be an error at the printer.

■ There may be a job in the Windows print queue which has stalled.

■ The printer may be paused or set to operate offline in the Windows print queue.
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5.7 Frequently asked questions

Question Answer

How do I know if my printer has the 
Ethernet option installed?

All printer models come with Ethernet installed as standard equipment.

What PC operating systems work 
with my Ethernet printer?

■ Windows 7 (32- and 64-bit)
■ Windows 8 / 8.1 (32- and 64-bit)
■ Windows 10 (32- and 64-bit)
■ Windows Server 2008 R1 (32- and 64-bit)
■ Windows Server 2008 R2 (64-bit only)
■ Windows Server 2012
■ Windows Server 2012 R2 
■ Windows Server 2016 

How do I connect my printer to my 
network?

You can connect from the RJ45 network connection on the back of your printer 
to an available connection on your network (not directly to your PC). You can use 
a good CAT-5 or better cable to make this connection.

How can I find the MAC address of 
my Ethernet printer?

Do one of the following:
■ If you know the IP address of your printer, you can see the MAC address on 

the Home page of the print server. 
■ If you do not know the IP address or the printer does not work with a 

usable IP address, then the MAC address is listed in the data printed on the 
“Printer Settings” self-test card.

How can I find the IP address of my 
Ethernet printer?

You can find it on the printer display if the Ethernet option is functioning properly. 
Select Info, then click Next several times until the IP address is shown.

Can I print from my PC to multiple 
Ethernet printers? 

Choose Local printer… unless a shared network printer is to be installed on a 
print server.
Use the Windows Add Printer Wizard to create a printer instance to 
communicate to the printer at the new IP address. 
If the printer port is not listed as an existing port then a new Card Printer TCP/IP 
Port must be created and configured to communicate to the printer at the proper 
IP address.
See the appropriate Windows documentation for additional help.

Can multiple PCs print to my 
Ethernet printer? 

Yes. Each PC must install the printer driver software for the specific 
Ethernet-enabled printer and connect to the intended printer using the correct IP 
address.

Can I print from my PC to an 
Ethernet printer on a different 
network segment?

Yes. If you know the IP address of the printer on any segment of your network, 
you will be able to print to it.
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How do I upgrade the printer 
firmware in my Ethernet-enabled 
printer?

This is done in the same way as a USB-connected printer. The PC doing the 
upgrade must have a driver installed for the printer to be upgraded. This varies by 
the level of Microsoft Windows you are running. In general, 

1. Run the Driver Update Manager from the Settings > Devices > HDP6600 
Card Printer > Manage > Printing Preferences.

2. Go to the Utilities tab.
3. Select Update Manager.
4. Click Check for updates.
5. Select the printer you wish to update.
6. Select the update you wish to install.
7. Click Begin Updating Firmware.

How do I upgrade the print server 
firmware for my printer?

Since the print server is integrated into the main print firmware on the printer, 
there is not a separate firmware upgrade for the printer server. 
Note: Therefore, the upgrades are done with the main printer firmware.

What do I do if the IP address of 
my printer is being changed by my 
network?

Do one of the following:
■ Contact your network administrator. Ask that your current IP address be 

reserved or ask that they provide a specific IP address that you can use to 
configure the Ethernet interface.

■ Choose an IP address that you know is not used by any other PC, server or 
network device. Use those settings to configure your printer with static 
network settings. 

Note: Do not do this unless you know that these settings are always available.

How do I reconfigure my PC printer 
driver to connect to a different 
printer or different IP address? 

Choose Local printer… unless a shared network printer is to be installed on a 
print server. Use the Windows Add Printer Wizard to create a printer instance to 
communicate to the printer at the new IP address. If the printer port is not listed 
as an existing port then a new Card Printer TCP/IP Port must be created and 
configured to communicate to the printer at the proper IP address. See the 
appropriate Windows documentation for additional help.

How can I verify/change the IP 
address where my installed printer 
driver is expecting to find my 
printer?

This varies by the level of Microsoft Windows you are running. In general, 
1. Open the Settings > Devices > HDP6600 Card Printer > Manage > Printer 

Properties.
2. From the Ports tab, select Configure Port. The Host Name indicates the IP 

address of the connected printer. 
3. If this does not match your printer's IP address, you can change it from this 

window.
4. Enter the correct IP address.
5. Click OK.
6. Click Apply.
7. Click Close.

How do I configure my printer's IP 
settings?

Do one of the following:
■ By default, the printer is configured for dynamic IP address assignment. 

That is, it will try to get its IP address and other settings from your network. 
If it is given valid network settings, it use s those. 

■ You can choose to configure the printer, using a static IP address and 
network settings. 

Question Answer
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How do I choose a static IP address 
for my printer? 

Use the Network Settings page if you know the current IP address.
The printer also allows you to save the current network settings as static settings 
using the printer display menu (Network Settings > TCP/IP ), and then switch 
DHCP (dynamic IP address selection) to DISABLED. 
Note: You can save static addresses. However, they are not used until you 

reconfigure the printer to use those static addresses and reboot the printer.

What do the LEDs by the Ethernet 
connection on the back of the 
printer indicate?

The green LED indicates a valid Ethernet connection. 
The amber LED indicates network activity. 

How do I print a test page from 
Windows to verify the Ethernet 
configuration of the printer and 
printer driver? 

This varies by the level of Microsoft Windows you are running. In general, 
1. Open the Windows Settings page.
2. Select Settings > Devices > HDP6600 Card Printer > Manage > Printer 

Properties.
3. Select the General tab.
4. Ensure that the printing preferences are set correctly for the ribbon 

installed in your printer. Then select Print Test Page.
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5.8 Glossary of terms

Term Definition

Default gateway Specifies the address of the router (in a network using subnets) that forwards traffic to 
a destination outside of the subnet of the transmitting device.

DHCP (Dynamic Host 
Configuration Protocol)

The protocol used by a network to automatically assign network settings to connected 
devices so that they work together.

DNS (Domain Name System) Defines the network protocol that allows devices to find IP addresses from a network 
name server.

DNS domain suffix This is the suffix to be added to the domain name to make a complete name.

DNS server address This is the address of the server that provides the translation from a descriptive name to 
an IP address.

Guest user A user without rights to change printer settings.

ICMP (Internet Control 
Message Protocol)

The basic message protocol for the internet.

IP (Internet Protocol) The network protocol that identifies devices and messages by addresses so that 
communications can occur between devices on different local networks.

IP addresses Specifies the current IP addresses that are 32-bit values that are normally expressed in 
dotted-quad format. 
Note: This address must not be the same as another device on the same local network.

MAC (Media Access Control) The unique numeric value address associated with a network device that gives the 
device a unique identity. This address is assigned by the device manufacturer to ensure 
its uniqueness.

MIB (Management 
Information Base)

A formal description of the way an agent can be accessed using SNMP and the 
functions that can be managed.

Network settings The basic network parameters needed to configure the network interface. These include 
the IP address, the subnet mask, the default gateway, the DNS server address and the 
DNS domain suffix.

Ping A common utility or command that sends a message to network devices asking for a 
return message. This is used to diagnose if the device is on the network or to 
troubleshoot the connection.

Root user A user with administrative rights to change any printer settings.

SNMP (Simple Network 
Management Protocol)

This is protocol for the network management services. This protocol provides a means 
for network compliant devices, called agents, to store data about themselves in 
Management Information Bases (MIBs) and return this data to the SNMP requesters.

Subnet mask Specifies a 32-bit value that routers use to send a message to the correct subnet.

Syslog The standard method for logging system events.

TCP (Transmission Control 
Protocol)

The network protocol that allows reliable network communications between devices.

TCP/IP Network communications using TCP and IP protocols.

Telnet This is a common terminal emulation program that allows a user to send commands to a 
TCP/IP connected device and receive the responses.

UDP (User Datagram 
Protocol)

Defines a protocol for sending and receiving messages on a network.
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Section 6

6 Troubleshooting
This section provides specific procedures relating to diagnosing error messages shown on the printer display 
and the HID Printer Status monitor. 

6.1 Error message tables
This section provides two troubleshooting tables: the printer display error messages and the messages shown 
in the status monitor. Each table uses a 3-column presentation to present a specific error shown in the printer 
display or the printer error message shown on your PC, its cause and solution.

If you encounter problems beyond the capabilities of these two error message tables, visit: 
http://www.hidglobal.com/customer-service.

6.1.1 How to use the error message tables
The Printer Display Error Message column contains the error message and number that is displayed on the 
printer display. In the following table and screen capture examples, you can find the printer display error 
message or the Error Message number and then troubleshoot your printer as needed. 

You can also view the error information in the HID Status Monitor by clicking the icons on the error messages 
when they are displayed on your PC. These icons open the Configuration tab or the system Event Log tab of 
the status monitor, where you can view additional information. 

Printer Display Error Message Cause Solution

Ribbon Break/Jam
Error Message No. 523, 537

Matches the following screen shots.

The ribbon is not able to find the next 
panel correctly. Check for 
jams/breaks.

If jammed, clear the jam. If the ribbon 
is broken, repair it by taping the 
ribbon back on to the take-up core.
Press Resume to continue or Cancel 
to abort.

Opens the Configuration tab of the HID printer status monitor. See Section 4.1 Configuration tab to 
view current status of the selected instance.

Opens the System Event Log tab of the HID printer status monitor to view the latest print job 
statuses. See Section 4.2 System event log tab to view current print jobs.
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6.1.2 Troubleshooting with the printer display error message table
The printer display shows the current status of the printer.  

Printer Display Error Message Cause Solution

Calibrate Failed
Error Message No. 508, 535

Film or ribbon calibration has failed. Verify the film is installed correctly 
and there is not a ribbon installed. If 
this problem persists, call for 
technical assistance.

Calibrate Film
Error Message No. 504

Film sensors need to be calibrated. Press Cancel and then perform the 
film calibration procedure.

Calibrate Ribbon
Error Message No. 527

The print ribbon sensor is out of 
calibration.

Press Cancel and then perform the 
ribbon calibration procedure.

Card Jam
Error Message No. 467, 476, 484

A card is jammed in the print station 
or card flipping area of the printer.

Clear the jam.

Card Jam: Smart Card
Error Message No. 469

A card is jammed in the smart card 
encoding area of the printer.

Clear the jam.

Card Jam
Error Message No. 466

Card became jammed in the printer 
during transfer.

Clear the jam.

Card Not Found
Error Message No. 465

Card cannot be found in the printer. Verify that the card is not jammed in 
the printer and press Cancel.

Check Film
Error Message No. 501

The film is not able to move correctly. 
Check for jams/breaks.

Check for obstruction. If the problem 
persists, call for technical assistance.

Film Sensor Calibration Failure
Error Message No. 508

Film sensor failure. Reset the printer. Make sure film is 
installed correctly. Try again.

Ribbon Sensor Calibration Failure
Error Message No. 535

Ribbon sensor failure. Reset the printer and try again. If 
failure persists, call for technical 
assistance.

Empty Reject Bin
Error Message No. 490

The reject bin is full. Remove the large number of rejected 
cards from the reject bin.
Press OK to clear the notification 
message. 
In some cases, rejected cards are 
incomplete or pose a security risk, 
and should be disposed of properly.

Check Film
Error Message No. 500, 501, 506

The film is not able to move correctly. 
Check for jams/breaks.

Check for obstruction. If the problem 
persists, call for technical assistance.

Film Low
Error Message No. 503

The HDP® film will soon run out. If printing a large number of cards, 
replace the film now or monitor the 
printer until the film is gone and 
install a new film.

Film Out
Error Message No. 497, 499

The HDP film has run out. Install a new roll of film and press 
Resume to continue or Cancel to 
reset.

Invalid Film
Error Message No. 493

The HDP film has been programmed 
incorrectly or is damaged.

Verify the correct film is installed in 
the film cartridge.
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Failed to Initialize
Error Message No. 455, 456

An error has occurred during printer 
start up.

Reset the printer and try again. If 
problem persists, call for technical 
assistance.

Check Options File
Error Message No. 458

Printer not set up correctly or 
hardware failure.

Reset the printer and try again. If 
problem persists, call for technical 
assistance.

No Film
Error Message No. 498

Error reading film tag. Reset the printer and try again. If 
problem persists, call for technical 
assistance.

Ribbon Tag Error
Error Message No. 524

Error reading ribbon tag. Reset the printer and try again. If 
problem persists, call for technical 
assistance.

Heater Error
Error Message No. 558, 559

The flattener is too hot. Reset the printer and try again. If 
problem persists, call for technical 
assistance.

Flipper Jam
Error Message No. 480, 481

A card is jammed in the card flipping 
area of the printer.
The flipper table is jammed or 
non-functional.

Open the printer flipping module 
cover.
Clear any cards in the flipping 
module by opening the printer cover 
and pressing the Forward and/or 
Back buttons located on the printer 
display.
Ensure that the flipper module can 
rotate freely. Close the printer 
flipping module cover.
Press Resume on the printer display 
to continue printing.
To cancel the print, click Cancel Print 
from the HID Printer Status Monitor.

Head Resistance
Error Message No. 434

The EE setting in printer driver for 
head resistance is out of range.

Enter a value for Head Resistance in 
the EE settings in the printer driver.
Reset the correct value according to 
the steps in Section 3.4.8 Internal 
printer settings. If this problem 
persists, call for technical assistance.

See Manual
Error Message No. 435, 440

A hardware fault has prevented 
setting the correct printhead voltage.

Verify Head Resistance EE setting is 
correct. 
Reset the printer and try again.
If this problem persists, call for 
technical assistance.

Headlift Error
Error Message No. 436, 437, 442, 443

This is a problem with the printhead 
lift.

Reset the printer and try again.
If this problem persists, call for 
technical assistance.

Heater Error
Error Message No. 551, 557

The transfer heater roller is too hot. Reset the printer and try again.
If this problem persists, call for 
technical assistance.

Invalid Ribbon
Error Message No. 519

An unauthorized ribbon is installed in 
the printer.

Get the correct ribbon from your 
dealer.

Printer Display Error Message Cause Solution
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Headlift Error
Error Message No. 553, 554, 555, 556

There is a problem with the transfer 
roller headlift.

Reset the printer and try again. If 
problem persists, call for technical 
assistance.

Headlift Error
Error Message No. 560

There is a problem with the transfer 
roller headlift.

Reset the printer and try again. If 
problem persists, call for technical 
assistance.

Job Data Error
Error Message No. 544

The print data sent to the printer is 
corrupt or has been interrupted.

Reset the printer and try again.
If this problem persists, call for 
technical assistance.

Mag Verify Error
Error Message No. 487

Printer could not verify mag write.
OR
The magnetic stripe was not 
encoded properly.

Check the cards for correct mag 
stripe orientation and try again. 
Verify the mag coercivity selection in 
the driver matches that of the cards

Multiple Feed
Error Message No. 475

Multiple cards were fed into the 
printer.

Remove all cards and try again.

No E-card Encoder 
Error Message No. 451

You are trying to send encoding data, 
but the printer is not configured with 
this encoder type. 

To cancel, press Cancel Print.

No Film
Error Message No. 492

Film is not installed in the printer.
OR
Film RFID tag is bad.

Install the film and press Resume.
To cancel the print, press Cancel on 
the printer display or click Cancel 
Print from the HID Printer Status 
Monitor.

No Flip Module
Error Message No. 482

Two-sided job sent to a one-sided 
printer.

Using the printer display, verify the 
printer has flipper capabilities.
If flipper capabilities are present, 
ensure that the Print Both Sides 
option in the printer driver is set 
correctly.
Press Resume on the printer display 
to continue printing.
To cancel the print, click Cancel Print 
from the HID Printer Status Monitor.

No Mag Module
Error Message No. 486

Mag encoding job sent to the printer 
without a mag encoder.
You are trying to send encoding data, 
but the printer is not configured with 
this encoder type.

To cancel the print, click Cancel Print 
from the HID Printer Status Monitor.

No Ribbon
Error Message No. 518, 524

No ribbon is installed in the printer.
OR
The ribbon RFID tag is bad.

Install the correct ribbon and press 
Resume on the printer display.
To cancel the print, press Cancel on 
the printer display or click Cancel 
Print from the HID Printer Status 
Monitor.

See Manual
Error Message No. 444

An error was detected during 
printing.

Reset the printer and try again.
If this problem persists, call for 
technical assistance.

Printer Display Error Message Cause Solution
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Reboot Required
Error Message No. 430

Unspecified system error detected 
by the printer firmware.

Reset the printer and try again. 
If this problem persists, call for 
technical assistance.

Remove Card
Error Message No. 464

A card is jammed in the print station 
or card flipping area of the printer.

Clear the jam and press Cancel. 

Remove Ribbon
Error Message No. 533

The print ribbon is installed and 
needs to be removed.

Remove the ribbon.

Ribbon Break/Jam
Error Message No. 523, 537

The ribbon is not able to find the 
next panel correctly. Check for 
jams/breaks.

If jammed, clear the jam. If broken, 
repair the ribbon by taping the 
ribbon back on to the take-up core.
Press Resume to continue or Cancel 
to abort.

Ribbon Low
Error Message No. 528

The ribbon will soon run out. If printing a large number of cards, 
replace the ribbon now or monitor 
the printer until the ribbon is gone 
and install a new ribbon.

Check Ribbon
Error Message No. 530

The ribbon is not able to find the 
next panel correctly. Check for 
jams/breaks.

If jammed, clear the jam. If broken, 
repair by taping the ribbon back on 
to the take-up core.
Press Resume to continue or Cancel 
to abort.

Ribbon Out
Error Message No. 526, 538

The ribbon has run out. Install a new ribbon and press 
Resume to continue.

Invalid Ribbon
Error Message No. 519, 531

The ribbon is not installed properly 
or has been damaged.

Verify the correct ribbon is installed 
in the ribbon cartridge.

Unable to Feed
Error Message No. 474

The printer is unable to feed a card 
from the card hopper.

Verify there are cards in the card 
cartridge.
Verify cards are not stuck together or 
jammed, and they are the correct 
thickness.

See Manual
Error Message No. 453

Command resulted in an error. Verify correct utility command is sent 
to the printer.

Waiting for Data
Error Message No. 454

The printer has stopped receiving 
data from the PC.

Reset the printer and try again.
If this problem persists, call for 
technical assistance.

Wrong Film
Error Message No. 494

The print film installed in the printer 
does not match the film type 
selected in the printer driver.
OR
A self-test job cannot be printed with 
the print media installed.

Replace the film in the printer with 
the type specified by the printer 
driver.
A reboot is required.

Printer Display Error Message Cause Solution
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Wrong Ribbon
Error Message No. 520

The ribbon installed in the printer 
does not match the ribbon type 
selected in the printer driver.
OR
A self-test job cannot be printed with 
the print media installed.

Replace the ribbon in the printer with 
the type specified by the printer 
driver.

See Manual
Error Message No. 431, 432, 433, 452, 
457, 485, 547, 548, 549, 550

Unspecified system error is detected 
by printer firmware.

Reset printer and try again. If 
problem persists, call for technical 
assistance.

See Manual
Error Message No. 438

The print head has become too hot. Allow to cool off and try again.

Ribbon Temp Error
Error Message No. 441

The ambient temperature of the 
printer is too high.
OR
Sensor failure.

Allow to cool off and try again. If 
problem persists, call for technical 
assistance.

Please Install Film and Close Cover
Error Message No. 536

Film is not installed. Install the film. Press OK and run the 
calibration routine again.

Check Film/Card
Error Message No. 552

Card became jammed in printer 
during transfer.

Clear the jam.

Printer Display Error Message Cause Solution
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6.1.3 Troubleshooting the printer error message table 

Printer Error Message Cause Solution

See Manual
Fail To Initialize

A general printer error has occurred. Press Cancel on the printer or click 
Cancel Print from the HID Printer 
Status Monitor.

Card Not Found The printer is unable to find the card. Check the printer for the card or other 
obstruction. Remove the obstruction. 
To cancel the print, press Cancel on 
the printer display or click Cancel 
Print from the HID Printer Status 
Monitor.

Unable to Feed The printer is unable to feed a card 
from the card cartridge.

Ensure that cards are available and 
loaded correctly, press Resume on the 
printer display to continue printing.
To cancel the print, press Cancel on 
the printer display or click Cancel 
Print from the HID Printer Status 
Monitor.

Card Jam
Card Jam: Smart Card
Multiple Feed
Check Film/Card

A card has become jammed in the 
printer.

Open the printer front cover and 
remove the print ribbon and film 
cartridges.
Clear any cards in the printer by 
pressing the Forward and/or Back 
buttons on the printer display.
Re-insert the ribbon and close the 
printer front cover.
Press Resume on the printer display 
to continue printing.
To cancel the print, press Cancel on 
the printer display or click Cancel 
Print from the HID Printer Status 
Monitor.

Head Resistance Printhead resistance out of range. Verify that the head resistance 
stamped on print head matches value 
stored in EEPROM. Press Cancel on 
the printer display.

Ribbon Temp Error The ambient temperature of the 
printer is out of range.
OR
Sensor failure.

Press Cancel to cancel job. Allow the 
printer to cool and cycle the power to 
reboot.
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Flipper Jam The flipper table has jammed while 
either aligning itself or flipping a card.

Open the printer flipper module cover.
Clear any cards in the flipper module 
by pressing Forward and/or Back on 
the printer display.
Ensure that the flipper table can 
rotate freely. Close the printer flipper 
module cover.
Press Resume on the printer display 
to continue printing.
To cancel the print, press Cancel on 
the printer display or click Cancel 
Print from the HID Printer Status 
Monitor.

No Flip Module The printer does not have flipping 
capabilities.

Verify the printer has flipper 
capabilities by way of the printer 
display menu.
If flipper capabilities are present, 
ensure that the Print Both Sides 
option in the driver is set correctly.
Press Resume on the printer display 
to continue printing.
To cancel the print, press Cancel on 
the printer display or click Cancel 
Print from the HID Printer Status 
Monitor.

Wrong Ribbon 
Wrong Film

An incorrect ribbon or film is installed, 
or a driver setting is incorrect.

Check that the ribbon or film is 
correct for the printer and job. Press 
Resume on the printer display to 
continue printing.
To cancel the print, press Cancel on 
the printer display or click Cancel 
Print from the HID Printer Status 
Monitor.

No Ribbon 
No Film

No print ribbon or film is installed in 
the printer.
OR
Ribbon or film tag information 
corrupt.

Install the correct ribbon or film and 
press Resume on the printer display.

Ribbon Out
Film Out

The print ribbon or film installed in the 
printer is empty.

Install a new ribbon or film and press 
Resume on the printer display.

Calibrate Ribbon The ribbon sensor is not calibrated. Cancel the job, open the cover, 
remove the ribbon, close the cover, 
run the ribbon calibration routine.

Calibrate Film The film sensor is not calibrated. Cancel the job, run the film calibration 
routine.

Calibrate Failed The ribbon or film sensor failed 
calibration.

Verify the ribbon is removed, the film 
is installed, and print cover is closed. 
Run calibration again.

Printer Error Message Cause Solution
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Ribbon Break/Jam, Check Ribbon A ribbon break/jam has been 
detected inside the printer.

The printer has determined that the 
installed ribbon has either jammed or 
broken.
Open the printer cover and remove 
the print ribbon. If ribbon is jammed, 
remove the jam and tighten the 
ribbon.
Clear any cards in the printer by 
pressing the Forward and/or Back 
buttons on the printer display.
Tape the ends of the ribbon together 
and wind any excess onto the take-up 
spool of the print ribbon.
Re-install the print ribbon, close the 
printer cover and press Resume on 
the printer display to continue 
printing.
To cancel the print, press Cancel on 
the printer display or click Cancel 
Print from the HID Printer Status 
Monitor.

Check Film A film break/jam has been detected 
inside the printer.

Open the printer cover and remove 
the print film. Check the film and see 
if it is broken.
If the print film is not broken, re-install 
the print film, close the printer cover, 
and press Resume on the printer 
display to continue printing.
If the print film is broken, tape the 
ends of the print film together and 
wind any excess onto the take-up 
spool. Re-install the print film, close 
the printer cover and press Resume 
on the printer display to continue 
printing.
To cancel the print, press Cancel on 
the printer display or click Cancel 
Print from the HID Printer Status 
Monitor.

Invalid Film An incorrect print ribbon/print film 
has been installed in the printer. (This 
is if you are using SecureMark™ ribbon 
and film.)

A non-SecureMark ribbon or film is 
installed in a SecureMark printer.
Replace with the appropriate 
SecureMark ribbon or film and press 
Resume on the printer display to 
continue printing.
Install a certified print ribbon and 
press Resume on the printer display 
to continue printing.
To cancel the print, press Cancel on 
the printer display or click Cancel 
Print from the HID Printer Status 
Monitor.

Printer Error Message Cause Solution
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No Mag Module A print job with magnetic encoding 
was sent with no magnetic encoder 
installed in the printer.

Ensure that encoding data is not 
being sent with the print job and 
reprint the card. 

Mag Verify Error The printer is unable to verify 
encoded data.

Check the cards and click Cancel 
Print on the printer display.

No Ecard Encoder No smart prox card encoder is 
installed in the printer.

To cancel, click Cancel Print on the 
printer display.

Headlift Error The headlift sensor is not detecting 
movement from the headlift cam. This 
can occur for the printhead, transfer 
roller, or card flattener.

Reboot the printer by cycling the 
power.
To cancel, press Cancel Print on the 
printer display.

Waiting For Data
Job Data Error

Entire print job is unable to be sent to 
the printer

Verify physical connection to the 
printer. To cancel, press Cancel Print 
on the printer display.

Heater Error The transfer roller or card flattener 
can not achieve correct temperature.

To cancel, press Cancel Print on the 
printer display. Reboot the printer by 
cycling the power.

Printer Error Message Cause Solution
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6.2 Resolving common errors 
Confirm that the system meets the minimum requirements.

Access https://www.support.microsoft.com and search for your Microsoft OS system requirements.

Confirm the correct installation of the printer driver:

■ Close the software program and check the printer driver.

■ Reboot the computer.

■ Ensure the printer driver is installed correctly. 

Note: This especially pertains if an obsolete driver was recently removed.

Ensure the correct setup options in the printer driver are selected. Confirm that the driver is current by 
checking at: http://www.hidglobal.com/drivers.

Confirm the correct installation of the flipper table module assembly:

1. Reboot the computer.

2. Ensure that the print both sides option in the printer driver is set correctly.

3. Verify the flipper table module assembly is functioning properly by printing out cards in a test run.

Determine the problem with printing from the application: 

■ Print a self-test from the printer.

On the printer display, select  >Test Prints > Settings to ensure that the printer is functioning 
properly.

■ Print the Windows test page from your computer.

a. From the Printing Preferences window, select the Utilities tab > Self Tests.

b. From the Self Tests tab, select one of the tests in the list, and click Run Test.

■ Use WordPad to print a test card. 

a. Open WordPad and type: This is a test.

b. Go to the File menu and select Print. 

c. Select HDP6600 Card Printer and click Apply. 

d. Click Print.

Determine whether there is adequate hard disk space.

Note: A large volume of temporary files on the computer can cause communications errors. Use the Disk 
Cleanup feature in your Windows Settings to free up disk space by deleting unnecessary files.
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